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SAR TEST REPORT 
Report Number: M141025R_FCC_EM7355_SAR_GSM-UMTS 

WWAN FCC ID: EJE-EM7355D Canada IC: 337J-EM7355D  
 

1.0 GENERAL INFORMATION 
Test Sample:  Portable Notebook Computer with Intel or Atheros WLAN Modules  
Radio Module Under Test: EM7355  
Interface Type: Mini-PCI Module 
Device Category:  Portable Transmitter 
Test Device: Pre-Production Unit 
Host PC model: Lifebook T725
WWAN FCC ID: 
WWAN IC: 

EJE-EM7355D 
337J-EM7355D  

RF exposure Category:  General Population/Uncontrolled
Manufacturer: Fujitsu Limited 
  
Test Standard/s: 1. 447498 D01 General RF Exposure Guidance v05r02  

616217 D04 SAR for laptop and tablets v01r01 
941225 D01 SAR test for 3G devices v03  
941225 D05 SAR for LTE Devices v02r03  
865664 D01 SAR Measurement 100 MHz to 6 GHz v01r03  
865664 D02 RF Exposure Reporting v01r01 

 2. Radio Frequency Exposure Compliance of Radiocommunication 
Apparatus (All Frequency Bands) RSS-102 

 3. EN 62209-2:2010
Human exposure to radio frequency fields from hand-held and 
bodymounted wireless communication devices. Human models, 
instrumentation, and procedures.    
Part 2: Procedure to determine the specific absorption rate (SAR) for 
wireless communication devices used in close proximity to the human 
body (frequency range of 30 MHz to 6 GHz) 

 4. IEEE 1528: 2013
Recommended Practice for Determining the Peak Spatial-Average 
Specific Absorption Rate (SAR) in the Human Head Due to Wireless 
Communications Devices: Measurement Techniques. 

Statement Of Compliance: The Fujitsu Notebook Computer Lifebook T725 with Sierra Wireless 
GSM/UMTS/LTE Module EM7355 complied with the FCC General 
public/uncontrolled RF exposure limits of 1.6mW/g per requirements 
of 47CFR2.1093(d). It also complied with IC RSS-102 requirements. 

Highest Reported SAR: 850 MHz GSM Band - 1.404 mW/g mW/g 
  
Test Dates: 29th October to 26th November 2014 
 
Test Officer: 
 
   

 

 Peter Jakubiec Emad Mansour Mahan 
Ghassempouri 

Authorised Signature: 

 Chris Zombolas
Technical Director 
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SAR TEST REPORT 
Portable Notebook Computer 

Model: Lifebook T725 
Report Number: M141025R_FCC_EM7355_SAR_GSM-UMTS 

 
2.0 INTRODUCTION 

 
Testing was performed on the Fujitsu Notebook PC, Model: Lifebook T725 with SIERRA Mini-PCI Wireless 
WAN Module Model: EM7355, with INTEL Mini-PCI Wireless LAN/Bluetooth combo Module (Stone Peak 
802.11a/b/g/n/ac), Model: 7265NGW. The EM7355 module is an OEM product.  The Mini-PCI Wireless WAN 
(WWAN) was tested in the dedicated host – Model Lifebook T725. The system tested will be referred to as the 
DUT throughout this report. 
 
3.0 TEST SAMPLE TECHNICAL INFORMATION 

 (Information supplied by the client) 
 
3.1 WWAN Details 
 

Transmitter: Mini-Card Wireless WAN Module 
FCC ID: EJE-EM7355D 
IC: 337J-EM7355D 
Wireless Module: WWAN (UMTS/EVDO/LTE combo)  
Model Number: EM7355 
Manufacturer: SIERRA WIRELESS INC 
Modulation Type: TDMA for GSM/GPRS 

QPSK and QAM for UMTS 
QPSK and 16-QAM for LTE 
CDMA for 1xRTT, QPSK and 8-PSK for EvDo 

GSM Frequency Bands: 850 / 1900 MHz 
UMTS Frequency Bands: Band II (1900MHz)/Band IV (1700MHz)/Band V (835MHz) 
CDMA bands:  Band BC0 (850 MHz)/Band BC10 (850 MHz)/Band BC1 (1900 MHz) 
LTE bands: Band IV (1700MHz)/ Band XIII (750MHz)/Band XVII (700MHz)/ Band 

XXV (1900MHz) 
Antenna type:  Main: Monopole, AUX: PIFA 
Antenna Manufacturer:  NISSEI ELECTRIC CO. LTD.  
Antenna Part Number:  Main: CP519214, AUX: CP519215 
Output Power: 32.5  1 dBm in 850 MHz GPRS/27  1 dBm in 850 MHz EGPRS 

29.5  1 dBm in 1900 MHz GPRS/26  1 dBm in 1900 MHz EGPRS  
23  1 dBm in UMTS bands 
24 +0.5/-1 dBm in CDMA bands 
23  1 dBm in LTE bands 
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3.2 Test Signal, Frequency and Output Power 
 
The DUT was provided by Fujitsu Limited It was put into operation using a Rohde & Schwarz CMU200 and 
Agilent PXT E6621A (LTE) Radio Communication Testers.  The channels utilised in the measurements were 
the traffic channels shown in the table below.  The power level was set to Class 4 for 850 MHz and Class 1 for 
1900 MHz GSM bands, class 3 for 850, 1700 and 1900 MHz UMTS bands, Power Class 3 for the 850 MHz 
(BC0/BC10) Power Class 2 1900 MHz (BC1) CDMA bands and class 3 for 700, 750, 1700 and 1900 MHz LTE 
bands. 
 

Channels and Output power: 

Table 1 

Channel and Mode 
 

Frequency
MHz 

Average 
Output Power 

dBm 
GPRS Mode  

Channels 128, 190 and 251 824.2, 836.6 and 848.8 32.5 (+/- 1dB) 
Channels 512, 661 and 810 1850.2, 1880 and1909.8  29.5 (+/- 1dB) 

UMTS Mode   
Channels 4132, 4183 and 4233 826.4, 836.6 and 846.6 23 (+/- 1dB) 
Channels 1312, 1427 and 1513 1712.4, 1735.4 and 1752.6 23 (+/- 1dB) 
Channels 9262, 9400 and 9538 1852.4, 1880 and 1907.6 23 (+/- 1dB) 

CDMA Mode   
Channels 1013, 384 and 777 824.7, 836.52 and 848.31 24 (+0.5/-1dB) 
Channels 476, 560 and 684 817.9, 820 and 823.1 24 (+0.5/-1dB) 
Channels 25, 600 and 1175 1851.25, 1880 and 1908.75 24 (+0.5/-1dB) 

LTE Mode   
Channels 23780, 23790 and 23800 709, 710 and 711 23 (+/- 1dB) 
Channels 23230 782 23 (+/- 1dB) 

Channels 20050, 20175 and 20300 1720, 1732.5 and 1745 23 (+/- 1dB) 

Channels 26140, 26365 and 26590 1860, 1882.5 and 1905 23 (+/- 1dB) 
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3.3 DUT (Notebook PC) Details 
 
 

DUT: LIFEBOOK T series  
Model Name: T725 
Serial Number: Pre-production Sample 
Manufacturer: FUJITSU LIMITED 
  
CPU Type and Speed: Core i7  2.6GHz   
LCD 12.5”HD+(1366x768) : LP125WH2 
Graphics chip None 
Wired LAN: Intel  218LM : 10 Base-T/100 Base-TX/1000Base-T 
Modem: None 
Port Replicator Model: FPCPR213 
  
AC Adapter Model: 90W: A13-090P1A(Chicony), A13-090P2A (Chicony) 

      ADP-90BE D(Delta), ADP-90BE C(Delta) 
80W: ADP-80SB A(Delta), ADP-80SB B(Delta) 
65W: ADP-65MD B(Delta), ADP-65MD C(Delta) 
          A13-065N2A(Chicony), A13-065N3A(Chicony)  

Voltage: 19 V 
Current Specs: 4.74A  / 4.22A / 3.42A 
Watts: 90W  / 80W / 65W 
  

 
3.4 WLAN Details 
 
 

Transmitter: M.2 Wireless LAN Module (WLAN parts) 
Wireless Module: Intel Dual Band Wireless-AC 7265 (Stone Peak) (11ac/abgn) 
Model Number: 7265NGW 
Manufacturer: Intel Corporation 
  
Wi-Fi standard 802.11ac 2x2 
Wi-Fi TX/RX chains  2x2 chains 
Supported Bands  2.4GHz, 5GHz 
Antenna Allocation Main: Wi-Fi only, Aux: Shared Wi-Fi, BT 
Wi-Fi TX/RX Throughput 867Mbps 
Bluetooth Core  Bluetooth 4.0 
Antenna Types: Nissei Inverted F antenna 
Power Supply: 3.3 VDC from PCI bus 
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3.5 Test sample Accessories 
 
3.5.1 Battery Types 
One type of Fujitsu Lithium Ion battery is used to power the DUT. 
 
Standard Battery      
Model FPCBP446 
V/mAh 11.25V/6000mAh 
 
4.0 TEST SIGNAL, FREQUENCY AND OUTPUT POWER 
 
For the SAR measurements the DUT was operating at full transmit power. The fixed frequency channels used 
in the testing are shown in Table Below. 
 
The frequency span of the WWAN bands was more than 10MHz consequently; the SAR levels of the test 
sample were measured for lowest, centre and highest channels in the applicable modes. There were no wires 
or other connections to the DUT during the SAR measurements.  
At the beginning of the SAR tests, the conducted power of the DUT was measured after temporary modification 
of antenna connector inside the DUT’s TX RX compartment. Measurements were performed with a calibrated 
Power Meter. The results of this measurement are listed in tables below. Burst Average power was used to 
calculate the Frame Average power (100% Duty Cycle) which determines the worst case Multislot Class.  
 
EM7355 - IMEI – 356196050042429 
 
Conducted Power Measurement CDMA 2000 1xRTT 810/850/1900 MHz  
 
Configuration: 
Network > System Parameters > System ID = 2004; Network Identity > Network ID Number = 65535 
 
Service cfg > Primary Service Class > Selected Service = Loopback Service; Primary Service Class > 
Loopback Service > Selected Service Option = Service Option x (x -  2, 9 or 55); Service Option x (x -  2, 9 or 
55) > FCH Config > Frames > Frame Rate = Full; Selected Service Option > Service Option 55 > FCH Config > 
FCH > F-FCH-MO = 0001hex (Fundamental Channel Test Mode 1) or 0002hex (Fundamental Channel Test Mode 2) 
 
Service cfg > Primary Service Class > Selected Service = Test Data Service; Primary Service Class > Test 
Data Service > Selected Service Option = Service Option 32; Test Data Service Option 32 > FCCH & SCH 
Config > SCH0 Enable = Off (or On); Test Data Service Option 32 > FCCH & SCH Config > SCH1 Enable = Off 
(or On); Test Data Service Option 32 > FCCH & SCH Config > SCH0 Config  >  Data Rate = 9.6 kbps; FCCH & 
SCH Config > SCH1 Config  >  Data Rate = 9.6 kbps 
 
BS Signal > RF Settings > RF Power > CDMA Power = -104 dBm/1.23MHz (RF > External attenuation IN/OUT 
as per cable losses); RF Settings > RF Channel [BC0] = 384; RF Settings >RF Channel [BC10] = 560; RF 
Settings > RF Channel [BC1] = 325; BS Signal > RF Settings > RF Power > PICH Level = -7dB; BS Signal > 
FCH > FCH Level = -7.4 dB 
BS Signal > Power Control > Power Ctrl. Bits = All Up (Service Options 2,9 and 55)  
BS Signal > Power Control > Power Ctrl. Bits = Hold (Service Options 32) 
 

Table 2 

Cellular Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 

1 N/A SO 2 N/A N/A 23.97 24.06 23.69 
1 N/A SO 55 N/A N/A 23.79 24.03 23.61 
2 N/A SO 9 N/A N/A 23.88 24.05 23.69 
2 N/A SO 55 N/A N/A 23.87 23.89 23.69 

N/A 3 N/A SO 32 OFF 23.76 23.95 23.65 
N/A 3 N/A SO 32 ON 23.75* 24.03* 23.68* 
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*SCH1 Enable – rejected by DUT 
 

Table 3 

PCS Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 

1 N/A SO 2 N/A N/A 23.02 22.89 23.25 
1 N/A SO 55 N/A N/A 23.00 22.79 23.14 
2 N/A SO 9 N/A N/A 22.98 22.54 23.21 
2 N/A SO 55 N/A N/A 22.95 22.41 23.23 

N/A 3 N/A SO 32 OFF 23.01 22.74 23.19 
N/A 3 N/A SO 32 ON 23.00* 22.44* 23.23* 

*SCH1 Enable – rejected by DUT 
 

Table 4 

BC10 Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 476 Ch. 560 Ch.684 

1 N/A SO 2 N/A N/A 24.04 24.11 24.25 
1 N/A SO 55 N/A N/A 24.03 24.16 24.23 
2 N/A SO 9 N/A N/A 24.12 24.05 24.16 
2 N/A SO 55 N/A N/A 24.12 24.10 24.21 

N/A 3 N/A SO 32 OFF 24.10 24.21 24.20 
N/A 3 N/A SO 32 ON 24.13* 24.07* 24.23* 

*SCH1 Enable – rejected by DUT 
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Conducted Power Measurement 1xEvDo Revision 0 850/1900 MHz 
 
Configuration: 
Network > Network Release = Release 0; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -105.5 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); 
RF Settings > RF Channel [BC0] = 283; RF Settings >RF Channel [BC10] = 560; RF Settings > RF Channel 
[BC1] = 150; Power Control > Power control bits = All Up  
Layer > Application Layer > Test Applications > FTAP Cfg > DRC > ACK Ch Fixed Mode = Ack.Always; 
DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > RTAP Cfg > Data > Min. Rate = 5 (153.6 
kbps); Data > Min. Rate = 5 (153.6 kbps) 
 

Table 5 

Cellular Band 
Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 
0 -81 dB 23.85 23.96 23.63 

 

Table 6 

PCS Band 
Release 0 Subtype Open Loop Adjust (BC1) Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 
0 -84 dB 22.91 22.87 23.15 

 

Table 7 

BC10 Band 
Release 0 Subtype Open Loop Adjust 

(BC10) 
Result (dBm) 

Ch. 476 Ch. 560 Ch.684 
0 -84 dB 23.95 24.02 24.12 
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Conducted Power Measurement 1xEvDo Revision A 850/1900 MHz 

 
Configuration: 
Network > Network Release = Release A; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -60 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); RF 
Settings > RF Channel [BC0] = 283; RF Settings >RF Channel [BC10] = 560; RF Settings > RF Channel [BC1] 
= 150; Power Control > Power control bits = All Up 
Subtype 0: 
Layer > Protocol View Filter = Release 0 Settings; Layer > Application Layer > Test Applications > FTAP Cfg > 
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > 
RTAP Cfg > Data > Min. Rate = 5 (153.6 kbps); Data > Max. Rate = 5 (153.6 kbps) 
Subtype 2: 
Layer > Protocol View Filter = Release A Settings; Layer > Application Layer > Test Applications > FTAP Cfg > 
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Rate = 16 (307.2 kbps, 2-slots); Test Applications > RTAP 
Cfg > Data > Min. Packet Size = 9 (4096 bits); Data > Max. Packet Size = 9 (4096 bits); 
 

Table 8 

Cellular Band 
Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 
0 -81 dB 23.87 24.01 23.59 
2 -81 dB 23.86 23.99 23.63 

 

Table 9 

PCS Band 
Release 0 Subtype Open Loop Adjust (BC1) Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 
0 -84 dB 22.50 22.25 22.82 
2 -84 dB 22.95 22.87 23.01 

 

Table 10 

BC10 Band 
Release 0 Subtype Open Loop Adjust 

(BC10) 
Result (dBm) 

Ch. 476 Ch. 560 Ch.684 
0 -84 dB 24.09 24.10 24.14 
2 -84 dB 23.94 23.97 24.06 
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Conducted Power Measurement LTE 
 
Configuration (Agilent PTX E6621A): 
Band selection: Frequency key (setup group) > Setting Method = EARFCN,  > Band = 13, and > UL EARFCN = 
23230 (UL channel number) 
 For QPSK: Mode Setup key (measurement/function group) > More soft key > PHY Settings soft key > Uplink 
Resource Allocation soft key > I_MCS = 5 
For 16-QAM: Mode Setup key (measurement/function group) > More soft key > PHY Settings soft key > Uplink 
Resource Allocation soft key > I_MCS = 15 
Resource Block settings: Mode Setup key (measurement/function group) > More soft key > PHY Settings soft 
key > Uplink Resource Allocation soft key > RB Size and RB Start 
Channel Bandwidth: Mode Setup key (measurement/function group) > Ch Bandwidth 
TTI configuration: Mode Setup key (measurement/function group) > More soft key > PHY Settings soft key > 
Uplink Resource Allocation soft key > RCT > UL Tx Pattern to ALL (to ensure that all available sub-frames are 
active and transmitting) 
Mode Setup key> More 2/2 soft key>RRC Settings soft key> More 3/3 soft key> Additional Spectrum Emission 
= 1 (to ensure that Additional Maximum Power Reduction (A-MPR) is switched off) 
 

Table 11 

Band 4 Channel Bandwidth – 1.4 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 19957 Ch. 20175 Ch.20393 

QPSK 1 0 22.2 22.42 22.49 
16-QAM 1 0 21.22 21.43 21.50 
QPSK 1 3 22.14 22.48 22.47 

16-QAM 1 3 21.23 21.38 21.50 
QPSK 1 5 22.19 22.49 22.48 

16-QAM 1 5 21.18 21.47 21.66 
QPSK 3 0 22.17 22.45 22.49 

16-QAM 3 0 21.3 21.54 21.6 
QPSK 3 1 22.16 22.41 22.45 

16-QAM 3 1 21.28 21.54 21.58 
QPSK 3 3 22.21 22.46 22.5 

16-QAM 3 3 21.26 21.52 21.57 
QPSK 6 0 21.27 21.5 21.50 

16-QAM 6 0 20.32 20.56 20.68 
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Table 12 

Band 4 Channel Bandwidth – 3 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 19965 Ch. 20175 Ch.20385 

QPSK 1 0 22.27 22.47 22.56 
16-QAM 1 0 21.27 21.48 21.52 
QPSK 1 8 22.24 22.52 22.53 

16-QAM 1 8 21.25 21.49 21.56 
QPSK 1 14 22.23 22.52 22.50 

16-QAM 1 14 21.25 21.68 21.50 
QPSK 8 0 21.24 21.51 21.55 

16-QAM 8 0 20.25 20.52 20.62 
QPSK 8 4 21.25 21.53 21.00 

16-QAM 8 4 20.26 20.49 19.92 
QPSK 8 7 21.27 21.57 21.75 

16-QAM 8 7 20.26 20.58 20.87 
QPSK 15 0 21.2 21.43 21.42 

16-QAM 15 0 20.26 20.55 20.60 
 

Table 13 

Band 4 Channel Bandwidth - 5 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 19975 Ch. 20175 Ch.20375 

QPSK 1 0 22.37 22.42 22.51 
16-QAM 1 0 21.35 21.44 21.66 
QPSK 1 12 22.3 22.47 22.51 

16-QAM 1 12 21.31 21.62 21.52 
QPSK 1 24 22.3 22.54 22.52 

16-QAM 1 24 21.31 21.75 21.54 
QPSK 12 0 21.25 21.47 21.48 

16-QAM 12 0 20.3 20.5 20.53 
QPSK 12 6 21.31 21.49 21.50 

16-QAM 12 6 20.32 20.51 20.59 
QPSK 12 13 21.22 21.52 21.44 

16-QAM 12 13 20.26 20.52 20.56 
QPSK 25 0 21.12 21.39 21.46 

16-QAM 25 0 20.24 20.51 20.53 
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Table 14 

Band 4 Channel Bandwidth - 10 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 20000 Ch. 20175 Ch. 20350 

QPSK 1 0 22.17 22.36 22.52 
16-QAM 1 0 21.23 21.38 21.69 
QPSK 1 25 22.25 22.5 22.49 

16-QAM 1 25 21.23 21.37 21.51 
QPSK 1 49 22.29 22.48 22.49 

16-QAM 1 49 21.3 21.66 21.53 
QPSK 25 0 21.18 21.28 21.07 

16-QAM 25 0 20.18 20.37 20.46 
QPSK 25 12 21.15 21.44 21.42 

16-QAM 25 12 20.16 20.46 20.51 
QPSK 25 25 21.21 21.39 21.40 

16-QAM 25 25 20.21 20.49 20.46 
QPSK 50 0 21.02 21.32 21.28 

16-QAM 50 0 20.06 20.31 20.37 
 

Table 15 

Band 4 Channel Bandwidth – 15 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 20025 Ch. 20175 Ch.20325 

QPSK 1 0 22.24 22.39 22.59 
16-QAM 1 0 21.27 21.31 21.83 
QPSK 1 36 22.25 22.49 22.55 

16-QAM 1 36 21.26 21.48 21.56 
QPSK 1 74 22.36 22.56 22.49 

16-QAM 1 74 21.27 21.56 21.68 
QPSK 36 0 21.09 21.19 21.45 

16-QAM 36 0 20.08 20.22 20.47 
QPSK 36 19 21.08 21.27 21.21 

16-QAM 36 19 20.08 20.33 20.29 
QPSK 36 39 21.12 21.4 21.29 

16-QAM 36 39 20.13 20.42 20.34 
QPSK 75 0 21.09 21.32 21.32 

16-QAM 75 0 20.07 20.3 20.36 
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Table 16 

Band 4 Channel Bandwidth – 20 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 20050 Ch. 20175 Ch.20300 

QPSK 1 0 22.21 22.35 22.45 
16-QAM 1 0 21.22 21.36 21.59 
QPSK 1 50 22.23 22.49 22.49 

16-QAM 1 50 21.26 21.37 21.69 
QPSK 1 99 22.36 22.63 22.50 

16-QAM 1 99 21.38 21.65 21.50 
QPSK 50 0 21.04 21.20 21.40 

16-QAM 50 0 20.03 20.17 20.38 
QPSK 50 24 21.14 21.30 21.32 

16-QAM 50 24 20.1 20.30 20.35 
QPSK 50 50 21.04 21.30 21.29 

16-QAM 50 50 20.10 20.31 20.34 
QPSK 100 0 21.09 21.32 21.28 

16-QAM 100 0 20.14 20.33 20.32 
 
 

Table 17 

Band 13 Channel Bandwidth - 5 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 23205 Ch. 23230 Ch.23255 

QPSK 1 0 23.51 23.48 23.58 
16-QAM 1 0 22.48 22.45 22.51 
QPSK 1 12 23.49 23.64 23.32 

16-QAM 1 12 22.46 22.69 22.35 
QPSK 1 24 23.61 23.51 23.27 

16-QAM 1 24 22.60 22.47 22.31 
QPSK 12 0 22.54 22.54 22.46 

16-QAM 12 0 21.59 21.62 21.50 
QPSK 12 6 22.45 22.55 22.47 

16-QAM 12 6 21.51 21.69 21.46 
QPSK 12 13 22.47 22.52 22.35 

16-QAM 12 13 21.57 21.56 21.33 
QPSK 25 0 22.49 22.50 22.31 

16-QAM 25 0 21.50 21.57 21.28 
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Table 18 

Band 13 Channel Bandwidth - 10 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 23230 Ch. 23230 Ch. 23230 

QPSK 1 0 - 23.39 - 
16-QAM 1 0 - 22.43 - 
QPSK 1 25 - 23.66 - 

16-QAM 1 25 - 22.70 - 
QPSK 1 49 - 23.31 - 

16-QAM 1 49 - 22.36 - 
QPSK 25 0 - 22.48 - 

16-QAM 25 0 - 21.51 - 
QPSK 25 12 - 22.60 - 

16-QAM 25 12 - 21.53 - 
QPSK 25 25 - 22.46 - 

16-QAM 25 25 - 21.54 - 
QPSK 50 0 - 22.35 - 

16-QAM 50 0 - 21.43 - 
 

Table 19 

Band 17 Channel Bandwidth - 5 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 23755 Ch. 23790 Ch.23825 

QPSK 1 0 23.66 24.10 23.68 
16-QAM 1 0 22.63 23.07 22.73 
QPSK 1 12 23.96 23.85 23.18 

16-QAM 1 12 22.93 22.84 22.39 
QPSK 1 24 23.95 23.34 23.17 

16-QAM 1 24 23.00 22.32 22.15 
QPSK 12 0 22.79 22.96 22.37 

16-QAM 12 0 21.87 21.98 21.43 
QPSK 12 6 22.94 22.85 22.25 

16-QAM 12 6 21.99 21.88 21.27 
QPSK 12 13 23.03 21.66 22.18 

16-QAM 12 13 22.00 21.71 21.21 
QPSK 25 0 22.91 22.68 22.17 

16-QAM 25 0 21.19 21.77 21.23 
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Table 20 

Band 17 Channel Bandwidth - 10 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 23780 Ch. 23790 Ch. 23800 

QPSK 1 0 23.72 23.82 23.95
16-QAM 1 0 22.71 22.81 22.93 
QPSK 1 25 23.91 23.82 23.54 

16-QAM 1 25 22.91 22.72 22.56 
QPSK 1 49 23.19 23.18 23.06 

16-QAM 1 49 22.09 22.19 22.04 
QPSK 25 0 22.81 22.85 22.80 

16-QAM 25 0 21.81 21.88 21.83 
QPSK 25 12 22.84 22.84 22.77 

16-QAM 25 12 21.89 21.91 21.75 
QPSK 25 25 22.53 22.48 22.24 

16-QAM 25 25 21.59 21.54 21.36 
QPSK 50 0 22.69 22.60 22.52 

16-QAM 50 0 21.63 21.55 21.52 
 

Table 21 

Band 25 Channel Bandwidth – 1.4 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 26047 Ch. 26365 Ch.26683 

QPSK 1 0 22.07 22.07 22.27 
16-QAM 1 0 21.03 21.03 21.28 
QPSK 1 3 21.94 21.93 22.30 

16-QAM 1 3 20.95 20.99 21.30 
QPSK 1 5 21.98 21.90 22.27 

16-QAM 1 5 20.97 20.93 21.25 
QPSK 3 0 21.94 22.02 22.25 

16-QAM 3 0 21.01 21.15 21.35 
QPSK 3 1 21.97 21.85 22.25 

16-QAM 3 1 21.02 21.03 21.33 
QPSK 3 3 21.98 21.85 22.19 

16-QAM 3 3 21.01 21.02 21.30 
QPSK 6 0 20.99 20.98 21.33 

16-QAM 6 0 20.12 20.03 20.39 
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Table 22 

Band 25 Channel Bandwidth – 3 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 26055 Ch. 26365 Ch.26675 

QPSK 1 0 22.10 22.12 22.30 
16-QAM 1 0 21.03 21.07 21.29 
QPSK 1 8 21.94 21.95 22.30 

16-QAM 1 8 20.98 20.96 21.28 
QPSK 1 14 21.98 21.91 22.32 

16-QAM 1 14 21.02 20.86 21.29 
QPSK 8 0 21.05 21.07 21.23 

16-QAM 8 0 20.01 20.05 20.22 
QPSK 8 4 20.92 21.05 21.27 

16-QAM 8 4 19.95 19.96 20.27 
QPSK 8 7 21.01 21.00 21.29 

16-QAM 8 7 19.99 19.97 20.25 
QPSK 15 0 20.92 20.96 21.28 

16-QAM 15 0 20.02 21.09 20.32 
 

Table 23 

Band 25 Channel Bandwidth - 5 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 26065 Ch. 26365 Ch.26665 

QPSK 1 0 22.02 22.11 22.18 
16-QAM 1 0 20.99 21.14 21.21 
QPSK 1 12 21.95 21.94 22.33 

16-QAM 1 12 20.99 21.00 21.31 
QPSK 1 24 22.06 21.92 22.26 

16-QAM 1 24 21.03 20.94 21.26 
QPSK 12 0 21.01 21.08 21.22 

16-QAM 12 0 20.05 20.11 20.21 
QPSK 12 6 20.95 21.01 21.26 

16-QAM 12 6 20.01 20.02 20.30 
QPSK 12 13 21.00 20.91 21.27 

16-QAM 12 13 19.99 19.95 20.30 
QPSK 25 0 20.83 20.95 21.26 

16-QAM 25 0 19.93 19.93 20.26 
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Table 24 

Band 25 Channel Bandwidth - 10 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 26090 Ch. 26365 Ch. 26640 

QPSK 1 0 22.18 22.14 22.10 
16-QAM 1 0 21.16 21.14 21.11 
QPSK 1 25 22.20 21.99 22.28 

16-QAM 1 25 21.18 21.02 21.27 
QPSK 1 49 22.22 21.94 22.29 

16-QAM 1 49 21.19 20.95 21.34 
QPSK 25 0 20.98 21.02 21.17 

16-QAM 25 0 20.02 20.09 20.20 
QPSK 25 12 21.00 20.97 21.19 

16-QAM 25 12 20.12 19.98 20.23 
QPSK 25 25 21.07 20.95 21.26 

16-QAM 25 25 20.09 19.97 20.26 
QPSK 50 0 20.95 20.90 21.11 

16-QAM 50 0 20.03 19.95 20.13 
 

Table 25 

Band 25 Channel Bandwidth – 15 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 26115 Ch. 26365 Ch.26615 

QPSK 1 0 22.13 22.18 22.01 
16-QAM 1 0 21.11 21.18 21.00 
QPSK 1 36 22.16 22.14 22.18 

16-QAM 1 36 21.14 21.16 21.15 
QPSK 1 71 22.25 21.89 22.41 

16-QAM 1 71 21.24 20.89 21.37 
QPSK 36 0 21.12 20.86 20.90 

16-QAM 36 0 20.10 19.88 19.91 
QPSK 36 19 20.96 20.86 21.06 

16-QAM 36 19 20.00 19.95 20.10 
QPSK 36 39 20.95 20.87 21.24 

16-QAM 36 39 20.01 19.90 20.20 
QPSK 75 0 20.95 20.84 20.95 

16-QAM 75 0 19.97 19.90 19.98 
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Table 26 

Band 25 Channel Bandwidth – 20 MHz 
Modulation 

scheme 
Resource 

Block 
 size 

Resource 
Block  

start (offset) 

Result (dBm) 

Ch. 26140 Ch. 26365 Ch.26590 

QPSK 1 0 22.14 22.25 21.90 
16-QAM 1 0 21.16 21.24 20.89 
QPSK 1 50 22.20 21.97 22.04 

16-QAM 1 50 21.17 21.02 21.06 
QPSK 1 99 22.29 21.91 22.39 

16-QAM 1 99 21.30 20.92 21.38 
QPSK 50 0 20.98 21.00 20.74 

16-QAM 50 0 20.06 20.02 19.78 
QPSK 50 24 21.03 21.02 20.89 

16-QAM 50 24 20.08 19.90 19.92 
QPSK 50 50 21.12 20.76 21.09 

16-QAM 50 50 20.10 19.85 20.08 
QPSK 100 0 21.07 20.79 20.93 

16-QAM 100 0 20.04 19.86 19.98 
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Table: Frequency and Conducted Power Results GSM 

Table 27 

Coding Scheme GPRS Multislot 
Class 

RF Channel Measured Power 
Burst Average 

(dBm) 

Calculated Power 
Frame Average 

(100% Duty Cycle) 
(dBm) 

CS1 10 128 32.40 26.22 
CS1 10 190 32.35 26.17 
CS1 10 251 32.26 26.08 
CS1 11 128 N/A N/A 
CS1 11 190 N/A N/A 
CS1 11 251 N/A N/A 
CS1 12 128 N/A N/A 
CS1 12 190 N/A N/A 
CS1 12 251 N/A N/A 

Table 28 

Coding Scheme EGPRS Multislot 
Class 

RF Channel Measured Power
Burst Avarage 

(dBm) 

Calculated Power
Frame Avarage 

(100% Duty Cycle) 
(dBm) 

MCS5 10 128 27.08 20.90 
MCS5 10 190 26.80 20.62 
MCS5 10 251 26.79 20.61 
MCS5 11 128 26.45 22.03 
MCS5 11 190 26.28 21.86 
MCS5 11 251 26.27 21.85 
MCS5 12 128 26.30 23.13 
MCS5 12 190 26.14 22.97 
MCS5 12 251 26.05 22.88 
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Table 29 

Coding Scheme GPRS Multislot 
Class 

RF Channel Measured Power 
Burst Avarage 

(dBm) 

Calculated Power 
Frame Avarage 

(100% Duty Cycle) 
(dBm) 

CS1 10 512 27.91 21.73 
CS1 10 661 28.15 21.97 
CS1 10 810 28.02 21.84 
CS1 11 512 N/A N/A 
CS1 11 661 N/A N/A 
CS1 11 810 N/A N/A 
CS1 12 512 N/A N/A 
CS1 12 661 N/A N/A 
CS1 12 810 N/A N/A 

Table 30 

Coding Scheme EGPRS Multislot 
Class 

RF Channel Measured Power
Burst Avarage 

(dBm) 

Calculated Power
Frame Avarage 

(100% Duty Cycle) 
(dBm) 

MCS5 10 512 23.93 17.75 
MCS5 10 661 23.88 17.70 
MCS5 10 810 23.93 17.75 
MCS5 11 512 23.58 19.16 
MCS5 11 661 23.49 19.07 
MCS5 11 810 23.67 19.25 
MCS5 12 512 23.45 20.28 
MCS5 12 661 23.42 20.25 
MCS5 12 810 23.54 20.37 

*DUT has no GPRS/EGPRS Multislot Class 11 and 12 capabilities 
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Conducted Power Measurement UMTS 850 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 

Table 31 

Channel No. βc βd Result (dBm) 
4132 8 15 23.15 
4183 8 15 23.29 
4233 8 15 23.12 

 
Conducted Power Measurement UMTS + HSDPA 850 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
  

Table 32 

Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR 
(dB) 4132 4183 4233 

1 2 15 8 8 8 22.73 22.92 22.69 0.0 
2 12 15 8 8 8 22.36 22.45 22.34 0.0 
3 15 8 8 8 8 22.27 22.35 22.10 0.5 
4 15 4 8 8 8 22.23 22.35 22.14 0.5 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 850 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 

Table 33 

HSPA+ :  Since 16QAM is not used for uplink, the uplink Category and release is same as HSUPA, i.e., CAT 6 Rel 6 
 
 
 
 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 4132 4183 4233 

1 10 15 8 8 8 6 4 1 20 22.48 22.53 22.05 0.0 
2 6 15 8 8 8 8 4 1 12 20.81 20.77 20.82 2.0 
3 15 9 8 8 8 8 4 2 15 21.57 21.30 21.41 1.0 
4 2 15 8 8 8 5 4 1 17 21.13 20.64 21.17 2.0 
5 15 15 8 8 8 7 4 1 21 22.56 22.74 22.76 0.0 
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Conducted Power Measurement UMTS 1700 MHz 
 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 

Table 34 

Channel No. βc βd Result (dBm) 
1312 8 15 22.28 
1427 8 15 22.43 
1513 8 15 22.42 

 
Conducted Power Measurement UMTS + HSDPA 1700 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
 3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  

Table 35 

Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR 
(dB) 1312 1427 1513 

1 2 15 8 8 8 21.74 22.02 21.95 0.0 
2 12 15 8 8 8 21.45 21.68 21.62 0.0 
3 15 8 8 8 8 21.23 21.43 21.4 0.5 
4 15 4 8 8 8 21.24 21.46 21.41 0.5 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 1700 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 
 

Table 36 

HSPA+ :  Since 16QAM is not used for uplink, the uplink Category and release is same as HSUPA, i.e., CAT 6 Rel 6 
 
 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 1312 1427 1513 

1 10 15 8 8 8 6 4 1 20 21.01 21.03 21.38 0.0 
2 6 15 8 8 8 8 4 1 12 19.37 19.51 19.74 2.0 
3 15 9 8 8 8 8 4 2 15 20.09 20.36 20.41 1.0 
4 2 15 8 8 8 5 4 1 17 19.39 19.5 20.04 2.0 
5 15 15 8 8 8 7 4 1 21 21.07 21.15 21.39 0.0 
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Conducted Power Measurement UMTS 1900 MHz  
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 

Table 37 

Channel No. βc βd Result (dBm) 
9262 8 15 21.94 
9400 8 15 21.96 
9538 8 15 22.08 

 
Conducted Power Measurement UMTS + HSDPA 1900 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
 3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  

Table 38 

Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR 
(dB) 9262 9400 9538 

1 2 15 8 8 8 21.43 21.52 21.70 0.0 
2 12 15 8 8 8 21.05 21.20 21.38 0.0 
3 15 8 8 8 8 20.87 20.94 21.06 0.5 
4 15 4 8 8 8 20.98 21.05 21.20 0.5 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 1900 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 
 

Table 39 

HSPA+ :  Since 16QAM is not used for uplink, the uplink Category and release is same as HSUPA, i.e., CAT 6 Rel 6 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 9262 9400 9538 

1 10 15 8 8 8 6 4 1 20 21.02 21.06 21.04 0.0 
2 6 15 8 8 8 8 4 1 12 19.54 18.95 19.25 2.0 
3 15 9 8 8 8 8 4 2 15 20.14 19.99 20.12 1.0 
4 2 15 8 8 8 5 4 1 17 19.44 19.32 19.63 2.0 
5 15 15 8 8 8 7 4 1 21 21.12 21.17 20.95 0.0 
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4.1 Battery Status 
The DUT battery was fully charged prior to commencement of measurement.  Each SAR test was completed 
within 30 minutes.  The battery condition was monitored by measuring the RF field at a defined position inside 
the phantom before the commencement of each test and again after the completion of the test. It was not 
possible to perform conducted power measurements at the output of the DUT, at the beginning and end of 
each scan due to lack of a suitable antenna port. The uncertainty associated with the power drift was less than 
5% and was assessed in the uncertainty budget. 
 
5.0 DETAILS OF TEST LABORATORY 
 
5.1 Location 
EMC Technologies Pty Ltd  
176 Harrick Road 
Keilor Park, (Melbourne) Victoria 
Australia 3042 
  
Telephone: +61 3 9365 1000 
Facsimile: +61 3 9331 7455 
email:  melb@emctech.com.au 
website: www.emctech.com.au 
 
5.2 Accreditations 
EMC Technologies Pty. Ltd. is accredited by the National Association of Testing Authorities, Australia (NATA).  
NATA Accredited Laboratory Number: 5292 
 
EMC Technologies Pty Ltd is NATA accredited for the following standards: 

Table 40 

AS/NZS 2772.2 2011: RF and microwave radiation hazard measurement 
ACMA: Radio communications (Electromagnetic Radiation - Human Exposure) Standard 2003 
    
EN 50360: 2001 Product standard to demonstrate the compliance of mobile phones with the basic 

restrictions related to human exposure to electromagnetic fields (300 MHz – 3 GHz) 
EN 62209-1: 2006 Human Exposure to radio frequency fields from hand-held and body-mounted wireless 

communication devices - Human models instrumentation and procedures. 
Part 1: Procedure to determine the specific absorption rate (SAR) for hand-held devices 
used in close proximity to the ear (300 MHz to 3 GHz) 

EN 62209-2:2010 Human Exposure to radio frequency fields from hand-held and body-mounted wireless 
communication devices - Human models instrumentation and procedures 
Part 2: Procedure to determine the specific absorption rate (SAR) for wireless 
communication devices used in close proximity to the human body (frequency range of 
30 MHz to 6 GHz 

IEEE 1528: 2013 Recommended Practice for Determining the Peak Spatial-Average Specific Absorption 
Rate (SAR) in the Human Head Due to Wireless Communications Devices: 
Measurement Techniques. 

Refer to NATA website www.nata.asn.au for the full scope of accreditation. 
 
5.3 Environmental Factors 
The measurements were performed in a shielded room with no background RF signals. The temperature in the 
laboratory was controlled to within 211C, the humidity was in the range 42% to 52%. The liquid parameters 
are measured daily prior to the commencement of each test.  Tests were performed to check that reflections 
within the environment did not influence the SAR measurements. The noise floor of the DASY5 SAR 
measurement system using the SN1380 probe was less than 5V in both air and liquid mediums. 
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6.0 DESCRIPTION OF SAR MEASUREMENT SYSTEM 

Table 41 

Applicable Head Configurations : None
Applicable Body Configurations : Lap Held Position 

: Edge On Position 
: Bystander

 
6.1 Probe Positioning System 
The measurements were performed with the state-of-the-art automated near-field scanning system DASY5 
Version 52 from Schmid & Partner Engineering AG (SPEAG). The DASY5 fully complies with the IEEE 1528 
and EN62209-1 and EN62209-2 SAR measurement requirements.  
 
6.2 E-Field Probe Type and Performance 
The SAR measurements were conducted with SPEAG dosimetric probe ET3DV6 Serial: 1380. Please refer to 
appendix C for detailed information. 
 
6.3 System Verification 
 
6.3.1 System Verification Results (750 MHz, 900 MHz, 1800 MHz and 1950 MHz) 
 
The following tables lists the dielectric properties of the tissue simulating liquid measured prior to SAR System 
Verification. The results of the System Verification are listed in columns 4 and 5. The forward power into the 
reference dipole for SAR System Verification was adjusted to 250 mW. 
 
Table: System Verification Results 

Table 42 

1. 
System 

Verification 
Date 

2. 
Frequency 

(MHz) 

3. 
r 

(measured) 

4. 
 (mho/m) 

(measured) 

5. 
Measured 

SAR 1g 

6. 
Measured 
SAR 10g 

7. 
Last 

Validation 
Date 

28th Oct. 14 900 54.5 1.07 2.89 1.89 16th Apr. 14 
29th Oct. 14 900 54.9 1.06 2.91 1.90 16th Apr. 14 
30th Oct. 14 900 56.2 1.07 2.93 1.91 16th Apr. 14 
31st Oct. 14 750 55.8 0.96 2.01 1.34 16th Apr. 14 
21st Nov. 14 1800 50.8 1.56 9.64 5.15 22nd Apr. 14 
24th Nov. 14 1800 50.8 1.55 9.52 5.07 22nd Apr. 14 
24th Nov. 14 1950 53.6 1.58 10.1 5.21 22nd Apr. 14 
25th Nov. 14 1950 51.4 1.60 10.3 5.34 22nd Apr. 14 
26th Nov. 14 1950 51.6 1.57 10.1 5.22 22nd Apr. 14 

 
 
6.3.2 Deviation from reference validation values 
The reference SAR values are derived using a reference dipole and flat section of the SAM phantom suitable 
for a centre frequency of 750, 900, 1800, and 1950 MHz. These reference SAR values are obtained from the 
IEEE Std 1528-2013 and are normalized to 1W.  
 
The SPEAG calibration reference SAR value is the SAR validation result obtained in a specific dielectric liquid 
using the validation dipole during calibration. The measured one-gram SAR should be within 10% of the 
expected target reference values shown in table below. 
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Table: Deviation from reference validation values @ (750, 900, 1800 MHz and 1950 MHz) 

Table 43 

Frequency 
and Date  

Measured 
SAR 1g 
(mW/g)  

Measured 
SAR 1g 
(Normalized 
to 1W) 

SPEAG 
Calibration 
reference 
SAR Value 
1g (mW/g)

Deviation 
From 
SPEAG 
Reference 
1g (%)

900 MHz 
28th Oct. 14 

2.89 11.56 11.1 4.14 

900 MHz 
29th Oct. 14 

2.91 11.64 11.1 4.86 

900 MHz 
30th Oct. 14 

2.93 11.72 11.1 5.59 

750 Mhz 
31st Oct. 14 

2.01 8.04 8.72 -7.80 

1800 MHz 
21st Nov. 14 

9.64 38.56 38.7 -0.36 

1800 MHz 
24th Nov. 14 

9.52 38.08 38.7 -1.60 

1950 MHz 
24th Nov. 14 

10.1 40.40 38.6 4.66 

1950 MHz 
25th Nov. 14 

10.3 41.20 38.6 6.74 

1950 MHz 
26th Nov. 14 

10.1 40.40 38.6 4.66 

NOTE: All reference validation values are referenced to 1W input power. 
 
6.3.3 Liquid Depth 15cm 

 
During the SAR measurement process the liquid level was maintained to a level of 15cm with a 
tolerance of 0.5cm.  
 

 
Photo of liquid Depth in Flat Phantom 
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6.4 Phantom Properties 
The phantoms used during the testing comply with the IEEE 1528 and EN62209-1 and EN62209-2 SAR 
measurement requirements.  
 
Table 44 Phantom Properties 
Phantom Properties  
Depth of Phantom   19 cm 
Width of flat section  40 cm 
Length of flat section  60 cm 
Thickness of flat section 2.0mm +/-0.2mm (flat section) 
Dielectric Constant <5.0 
Loss Tangent <0.05 

 
6.5 Tissue Material Properties 
The dielectric parameters of the human tissue simulating liquid were measured prior to SAR assessment using 
the HP85070A dielectric probe kit and HP8753ES Network Analyser.  The target dielectric parameters are 
shown in the following table. 

 
 

Table: Measured Body Simulating Liquid Dielectric Values at 750MHz 

Table 45 

Frequency 
Band 

r 
(target) 

 
(target) 

 
kg/m3 

709 MHz 
Body 55.4 5% 0.96 5% 1000 

710 MHz 
Body 55.4 5% 0.96 5% 1000 

711 MHz 
Body 55.4 5% 0.96 5% 1000 

782 MHz 
Body 55.4 5% 0.96 5% 1000 

NOTE: The body liquid parameters were within the required tolerances of 5%.  
 

Table: Measured Body Simulating Liquid Dielectric Values at 850MHz 

Table 46 

Frequency 
Band 

r 
(target) 

 
(target) 

 
kg/m3 

825 MHz 
Body 55.2 5% 0.97 5% 1000 

835 MHz 
Body 55.2 5% 0.97 5% 1000 

850 MHz 
Body 55.2 5% 0.97 5% 1000 

Note:  The body liquid parameters were within the required tolerances of 5%.   
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Table: Measured Body Simulating Liquid Dielectric Values at 1750MHz 

Table 47 

Frequency 
Band 

r 
(target) 

 
(target) 

 
kg/m3 

1710 MHz 
Body 53.3 5% 1.49 5% 1000 

1747 MHz 
Body 53.3 5% 1.49 5% 1000 

1785 MHz 
Body 53.3 5% 1.49 5% 1000 

Note:  The body liquid parameters were within the required tolerances of 5%.   
 

Table: Measured Body Simulating Liquid Dielectric Values at 1880MHz 

Table 48 

Frequency 
Band 

r 
(target) 

 
(target) 

 
kg/m3 

1850 MHz 
Body 53.3 5% 1.52 5% 1000 

1880.0 MHz 
Body 53.3 5% 1.52 5% 1000 

1910 MHz 
Body 53.3 5% 1.52 5% 1000 

Note:  The body liquid parameters were within the required tolerances of 5%.   
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6.6 Liquid Temperature and Humidity 
The humidity and dielectric/ambient temperatures were recorded during the assessment of the tissue material 
dielectric parameters. The difference between the ambient temperature of the liquid during the dielectric 
measurement and the temperature during tests was less than |2|C. 
 
Table: Temperature and Humidity recorded for each day 

Table 49 

Date Ambient 
Temperature (C) 

Liquid 
Temperature (C) 

Humidity (%) 

28th Oct. 14 20.7 20.4 50 
29th Oct. 14 20.3 20.0 45 
30th Oct. 14 20.4 20.2 46 
31st Oct. 14 20.2 19.8 47 
21st Nov. 14 20.0 19.6 43 
24th Nov. 14 20.3 20.0 52 
25th Nov. 14 20.5 20.1 52 
26th Nov. 14 20.5 20.2 47 

 
6.7 Simulated Tissue Composition Used for SAR Test 
The tissue simulating liquids are created prior to the SAR evaluation and often require slight modification each 
day to obtain the correct dielectric parameters. 
 
 
Table: Tissue Type: Body @ 850/900MHz Table: Tissue Type: Body @ 1800/1950MHz MHz 

  Volume of Liquid: 30 Litres      Volume of Liquid: 30 Litres 
 

Table 50 

Approximate 
Composition 

% By Weight  Approximate 
Composition 

% By Weight 

Distilled Water 56  Distilled Water 40.4 
Salt  0.76  Salt  0.5 
Sugar 41.76  Sugar 58 
HEC 1.21  HEC 1 
Bactericide 0.27  Bactericide 0.1 

 
 
6.8 Device Holder for Laptops and P 10.1 Phantom 
A low loss clamp was used to position the DUT underneath the phantom surface. 
 
Refer to Appendix A for photographs of device positioning 
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7.0 SAR MEASUREMENT PROCEDURE USING DASY5 
 
The SAR evaluation was performed with the SPEAG DASY5 system.  A summary of the procedure follows:
  

a) A measurement of the SAR value at a fixed location is used as a reference value for assessing the 
power drop of the DUT.  The SAR at this point is measured at the start of the test, and then again at the 
end of the test. 
 

b) The SAR distribution at the exposed flat section of the flat phantom is measured at a distance of 4 mm 
from the inner surface of the shell.  The area covers the entire dimension of the DUT and the horizontal 
grid spacing is 15 mm x 15 mm. The actual largest Area Scan has dimensions of 165 mm x 90 mm 
surrounding the test device. Based on this data, the area of the maximum absorption is determined by 
Spline interpolation.  

 
c) Around this point, a volume of 32 mm x 32 mm x 30 mm is assessed by measuring 5 x 5 x 8 points.  On 

the basis of this data set, the spatial peak SAR value is evaluated with the following procedure: 
 

(i) The data at the surface are extrapolated, since the centre of the dipoles is 2.7 mm away from the 
tip of the probe and the distance between the surface and the lowest measuring point is 4 mm.  
The extrapolation is based on a least square algorithm.  A polynomial of the fourth order is 
calculated through the points in z-axes.  This polynomial is then used to evaluate the points 
between the surface and the probe tip. 

 
(ii) The maximum interpolated value is searched with a straightforward algorithm.  Around this 

maximum the SAR values averaged over the spatial volumes (1 g and 10 g) are computed using 
the 3D-Spline interpolation algorithm.  The 3D-Spline is composed of three one-dimensional 
splines with the “Not a knot”- condition (in x, y and z-direction).  The volume is integrated with the 
trapezoidal – algorithm.  One thousand points (10 x 10 x 10) are interpolated to calculate the 
averages. 

 
(iii) All neighbouring volumes are evaluated until no neighbouring volume with a higher average value 

is found. 
 

(iv)  The SAR value at the same location as in Step (a) is again measured to evaluate the actual          
power drift. 
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8.0 MEASUREMENT UNCERTAINTY  
 

The uncertainty analysis is based on the template listed in the IEEE Std 1528-2013 for both Handset SAR tests 
and System Verification uncertainty. The measurement uncertainty of a specific device is evaluated 
independently and the total uncertainty for both evaluations (95% confidence level) must be less than 30%. 
 

Table 51:  Uncertainty Budget for DASY5 Version 52 – DUT SAR 

Error Description 
Uncert. 
Value 

Prob. 
Dist. 

Div. 
Ci 

(1g) 
Ci 

(10g) 
1g ui 10g ui  vi 

Measurement System                 

Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 

Axial Isotropy 4.7 R 1.73 0.7 0.7 1.90 1.90 ∞ 

Hemispherical Isotropy 9.6 R 1.73 0.7 0.7 3.88 3.88 ∞ 

Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 

Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 

System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 

Modulation response 2.4 R 1.73 1 1 1.39 1.39 ∞ 

Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 

Response Time 0.8 R 1.73 1 1 0.46 0.46 ∞ 

Integration Time 2.6 R 1.73 1 1 1.50 1.50 ∞ 

RF Ambient Noise 3 R 1.73 1 1 1.73 1.73 ∞ 

RF Ambient Reflections 3 R 1.73 1 1 1.73 1.73 ∞ 

Probe Positioner  0.4 R 1.73 1 1 0.23 0.23 ∞ 

Probe Positioning 2.9 R 1.73 1 1 1.67 1.67 ∞ 

Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 

Test Sample Related                 
Power Scaling 0 R 1.73 1 1 0.00 0.00 ∞ 

Test Sample Positioning 2.9 N 1.00 1 1 2.90 2.90 145 

Device Holder Uncertainty 3.6 N 1.00 1 1 3.60 3.60 5 
Output Power Variation – SAR Drift 
Measurement 

4.72 R 1.73 1 1 2.73 2.73 ∞ 

Phantom and Setup                 
Phantom Uncertainty 7.6 R 1.73 1 1 4.39 4.39 ∞ 

SAR Correction 1.9 R 1.73 1 0.84 1.10 0.92 ∞ 
Liquid Conductivity – Measurement 
uncertainty 

2.5 N 1.00 0.64 0.71 1.60 1.78 ∞ 

Liquid Permittivity – Measurement 
uncertainty 

2.5 N 1.00 0.6 0.26 1.50 0.65 ∞ 

Temp.unc. - Conductivity 3.4 R 1.73 0.78 0.71 0.77 0.70 ∞ 

Temp. unc. - Permittivity 0.4 R 1.73 0.23 0.26 0.04 0.05 ∞ 

Combined standard Uncertainty (uc)           11.49 11.42   

Expanded Uncertainty (95% CONFIDENCE 
LEVEL)     k= 2   22.98 22.83   

 
Estimated total measurement uncertainty for the DASY5 measurement system was 11.49%.  The extended 
uncertainty (K = 2) was assessed to be 22.98% based on 95% confidence level.  The uncertainty is not added 
to the measurement result.   



 WWAN - FCC ID: EJE-EM7355D IC: 337J-EM7355D Report No. M141025R_FCC_EM7355_SAR_GSM-UMTS            Page 36 of 485 

  

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 

 
 

Table 52:  Uncertainty Budget for DASY5 Version 52 – DUT SAR IEC62209-2 Uncertainty Budget 

Error Description 
Uncert. 
Value 

Prob. 
Dist. 

Div. 
Ci 

(1g) 
Ci 

(10g) 
1g ui 10g ui  vi 

Measurement System                 

Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 

Axial Isotropy 4.7 R 1.73 0.7 0.7 1.90 1.90 ∞ 

Hemispherical Isotropy 9.6 R 1.73 0.7 0.7 3.88 3.88 ∞ 

Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 

Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 

System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 

Modulation response 2.4 R 1.73 1 1 1.39 1.39 ∞ 

Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 

Response Time 0.8 R 1.73 1 1 0.46 0.46 ∞ 

Integration Time 2.6 R 1.73 1 1 1.50 1.50 ∞ 

RF Ambient Noise 3 R 1.73 1 1 1.73 1.73 ∞ 

RF Ambient Reflections 3 R 1.73 1 1 1.73 1.73 ∞ 

Probe Positioner  0.4 R 1.73 1 1 0.23 0.23 ∞ 

Probe Positioning 2.9 R 1.73 1 1 1.67 1.67 ∞ 

Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 

Test Sample Related                 
Power Scaling 0 R 1.73 1 1 0.00 0.00 ∞ 

Test Sample Positioning 2.9 N 1.00 1 1 2.90 2.90 145 

Device Holder Uncertainty 3.6 N 1.00 1 1 3.60 3.60 ∞ 
Output Power Variation – SAR Drift 
Measurement 

4.72 R 1.73 1 1 2.73 2.73 ∞ 

Phantom and Setup                 
Phantom Uncertainty 7.6 R 1.73 1 1 4.39 4.39 ∞ 
Liquid Conductivity – Deviation from target 
values 

5 R 1.73 0.64 0.43 1.85 1.24 ∞ 

Liquid Permittivity – Deviation from target 
values 

5 R 1.73 0.6 0.49 1.73 1.41 ∞ 

Liquid Conductivity – Measurement 
uncertainty 2.5 N 1.00 0.64 0.43 1.60 1.08 ∞ 

Liquid Permittivity – Measurement 
uncertainty 

2.5 N 1.00 0.6 0.49 1.50 1.23 ∞ 

Temp.unc. - Conductivity 3.4 R 1.73 0.78 0.71 1.53 1.39 ∞ 

Temp. unc. - Permittivity 0.4 R 1.73 0.23 0.26 0.05 0.06 ∞ 

Combined standard Uncertainty (uc)           11.79 11.56   

Expanded Uncertainty (95% CONFIDENCE 
LEVEL)     k= 2   23.58 23.11   

 
Estimated total measurement uncertainty for the DASY5 measurement system was 11.79%.  The extended 
uncertainty (K = 2) was assessed to be 23.58% based on 95% confidence level.  The uncertainty is not added 
to the measurement result.   
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Table 53: Uncertainty Budget for DASY5 Version 52 – System Verification 

Error Description 
Uncert. 
Value 

Prob. 
Dist. 

Div. 
Ci 

(1g) 
Ci 

(10g) 
1g ui 10g ui  vi 

Measurement System                 
Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 

Axial Isotropy 4.7 R 1.73 1 1 2.71 2.71 ∞ 

Hemispherical Isotropy 9.6 R 1.73 0 0 0.00 0.00 ∞ 

Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 

Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 

System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 

Modulation response 0 R 1.73 1 1 0.00 0.00 ∞ 

Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 

Response Time 0 R 1.73 1 1 0.00 0.00 ∞ 

Integration Time 0 R 1.73 1 1 0.00 0.00 ∞ 

RF Ambient Noise 1 R 1.73 1 1 0.58 0.58 ∞ 

RF Ambient Reflections 1 R 1.73 1 1 0.58 0.58 ∞ 

Probe Positioner  0.8 R 1.73 1 1 0.46 0.46 ∞ 

Probe Positioning 6.7 R 1.73 1 1 3.87 3.87 ∞ 

Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 

Dipole Related                 
                  

Deviation of exp. dipole 5.5 R 1.73 1 1 3.18 3.18 ## 

Dipole Axis to Liquid Dist. 2 R 1.73 1 1 1.15 1.15 ## 

Input power & SAR drift 3.40 R 1.73 1 1 1.96 1.96 ∞ 

Phantom and Setup                 
Phantom Uncertainty 4 R 1.73 1 1 2.31 2.31 ∞ 
Liquid Conductivity – Deviation from target 
values 

5 R 1.73 0.64 0.43 1.85 1.24 ∞ 

Liquid Permittivity – Deviation from target 
values 

5 R 1.73 0.6 0.49 1.73 1.41 ∞ 

Liquid Conductivity – Measurement 
uncertainty 

2.5 N 1.00 0.78 0.71 1.95 1.78 ∞ 

Liquid Permittivity – Measurement 
uncertainty 

2.5 N 1.00 0.26 0.26 0.65 0.65 ∞ 

Temp.unc. - Conductivity 3.4 R 1.73 0.78 0.71 0.77 0.70 ∞ 

Temp. unc. - Permittivity 0.4 R 1.73 0.23 0.26 0.04 0.05 ∞ 

Combined standard Uncertainty (uc)           10.02 9.84   

Expanded Uncertainty (95% CONFIDENCE 
LEVEL)     k= 2   20.05 19.68   

 
Estimated total measurement uncertainty for the DASY5 measurement system was 10.02%.  The extended 
uncertainty (K = 2) was assessed to be 20.05% based on 95% confidence level.  The uncertainty is not added 
to the System Verification measurement result.   
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9.0 EQUIPMENT LIST AND CALIBRATION DETAILS 
 

Table 54: SPEAG DASY5 Version 52 

Equipment Type Manufacturer Model Number Serial Number 
Calibration 

Due 
Used For 
this Test? 

Robot - Six Axes Staubli RX90BL N/A Not applicable  

Robot Remote Control SPEAG CS7MB RX90B Not applicable  

SAM Phantom SPEAG N/A 1260 Not applicable  

SAM Phantom SPEAG N/A 1060 Not applicable  

Flat Phantom  AndreT 10.1 P 10.1 Not Applicable  

Flat Phantom  AndreT  9.1 P 9.1 Not Applicable  

Flat Phantom  SPEAG ELI 4.0 1101 Not Applicable  

Data Acquisition Electronics SPEAG DAE3 V1 359 06-June-2015  

Data Acquisition Electronics SPEAG DAE3 V1 442 10-Dec-2014  

Probe E-Field - Dummy SPEAG DP1 N/A Not applicable  

Probe E-Field SPEAG ET3DV6 1380 13-Dec-2014  

Probe E-Field SPEAG ET3DV6 1377 10-June-2015  

Probe E-Field SPEAG ES3DV6 3029 Not Used  

Probe E-Field SPEAG EX3DV4 3956 13-June-2015  

Probe E-Field SPEAG EX3DV4 3657 17-Dec-2014  

Validation Source 150 MHz SPEAG CLA150 4003 3-Dec-2016  

Antenna Dipole 300 MHz SPEAG D300V3 1012 11-Dec-2015  

Antenna Dipole 450 MHz SPEAG D450V3 1074 11-Dec-2015  

Antenna Dipole 750 MHz SPEAG D750V2 1051 13-Dec-2016  

Antenna Dipole 900 MHz SPEAG D900V2 047 22-June-2015  

Antenna Dipole 1640 MHz SPEAG D1640V2 314 20-June-2015  

Antenna Dipole 1800 MHz SPEAG D1800V2 242 20-June-2015  

Antenna Dipole 1950 MHz SPEAG D1950V3 1113 6-Dec -2015  

Antenna Dipole 2300 MHz SPEAG D2300V2 1032 22-Aug-2016  

Antenna Dipole 2450 MHz SPEAG D2450V2 724 04-Dec-2015  

Antenna Dipole 2600 MHz SPEAG D2600V2 1044 13-Dec-2016  

Antenna Dipole 3500 MHz SPEAG D3500V2 1002 13-July-2013  

Antenna Dipole 5600 MHz SPEAG D5GHzV2 1008 16-Dec-2014  

RF Amplifier  EIN 603L N/A *In test   

RF Amplifier  Mini-Circuits ZHL-42 N/A *In test   

RF Amplifier  Mini-Circuits ZVE-8G N/A *In test   

Synthesized signal generator Hewlett Packard 86630A 3250A00328 *In test  

RF Power Meter Hewlett Packard 437B 3125012786 28-Aug-2014  

RF Power Sensor 0.01 - 18 GHz Hewlett Packard 8481H 1545A01634 29-Aug-2014  

RF Power Meter Rohde & Schwarz NRP 101415 18-Sept-2014  

RF Power Sensor Rohde & Schwarz NRP - Z81 100174     18-Sept-2014  

RF Power Meter Dual Hewlett Packard 435A 1733A05847 *In test  

RF Power Sensor Hewlett Packard 8482A 2349A10114 *In test  

Network Analyser Hewlett Packard 8714B GB3510035 14-Oct-2015  

Network Analyser Hewlett Packard 8753ES JP39240130 10-Nov-2015  

Dual Directional Coupler Hewlett Packard 778D 1144 04700 *In test  

Dual Directional Coupler  NARDA 3022 75453 *In test  

Radio Communication Test Set Rohde & Schwarz CMU200 101573 Not Applicable  

Radio Communication Test Set Anritsu MT8820A 6200240559 Not Applicable  

Radio Communication Test Set Agilent PXT E6621A MY51100168 Not Applicable  

* Calibrated during the test for the relevant parameters. 
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10.0 TEST METHODOLOGY 
Notebooks should be evaluated in normal use positions, typical for lap-held bottom-face only. However the 
number of positions will depend on the number of configurations the laptop can be operated in. The 
“LIFEBOOK T series” can be used in either a conventional laptop position (see Appendix A) or a Tablet 
configuration. The antenna location in the “LIFEBOOK T series” is closest to the top of the screen when used in 
a conventional laptop configuration and due to the separation distances involved between the phantom and the 
laptop antenna, testing is not required in this position.  
 
10.1  Positions 
 
10.1.1 “Lap Held” Position Definition (0mm spacing) 
The DUT was tested in the 2.00 mm flat section of the ELI4 Flat phantom for the “Lap Held” position. The 
Transceiver was placed at the bottom of the phantom and suspended in such way that the back of the DUT 
was touching the phantom. This device orientation simulates the PC’s normal use – being held on the lap of the 
user. A spacing of 0mm ensures that the SAR results are conservative and represent a worst-case position. 
 
10.1.2 “Edge On” Position 
The DUT was tested in the (2.00 mm) flat section of the ELI4 Flat phantom for the “Edge On” position. The 
Antenna edge of the Transceiver was placed underneath the flat section of the phantom and suspended until 
the edge touched the phantom. Refer to Appendix A for photos of measurement positions. 
 
10.1.3 “Bystander” Position (25mm spacing) 
The DUT was tested in the 2.00 mm flat section of the ELI4 Flat phantom for the “Bystander” position. The 
Transceiver was placed at the bottom of the phantom and suspended in such way that the back of its LCD 
screen was parallel to phantom and at 25mm distance.  This orientation simulates use of the device in a way 
that allows occasional RF exposure of the nearby person (Bystander).  
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10.2  List of All Test Cases (Antenna In/Out, Test Frequencies, User Modes) 
The DUT has a fixed antenna. Depending on the measured SAR level up to three test channels with the test 
sample operating at maximum power were recorded. The following table represents the matrix used to 
determine what testing was required. All relevant provisions of KDB 447498 and KDB 941225 are applied for 
SAR measurements of the host system.  
 
Table: Testing configurations 

Table 55 

Phantom 
Configuration  

Device Mode 
WWAN Band 
Name  

Test Configurations
Channel 
(Low) 

Channel 
(Middle) 

Channel 
(High) 

Lap Held/ Edge 
On/ Bystander 

GPRS 850 MHz   x  

 GPRS 1900 MHz  x  
 EGPRS 850 MHz   x  
 EGPRS 1900 MHz  x  
 WCDMA 850 MHz  x  
  WCDMA 1700 MHz  x  
 WCDMA 1900 MHz  x  
 WCDMA + HSDPA 

850 MHz 
 x  

 WCDMA + HSDPA 
1700 MHz 

 x  

 WCDMA + HSDPA 
1900 MHz 

 x  

 LTE 700 MHz  x  
 LTE 750 MHz  x  
 LTE 1700 MHz  x  
 LTE 1950 MHz  x  
 
Legend 

X Testing Required in this configuration 
  
 Testing required in this configuration only if SAR of middle channel is more than 3dB 

below the SAR limit or it is the worst case. 
X Additional SAR measurement for the HSDPA and HSUPA modes 
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11.0 SAR MEASUREMENT RESULTS 
 
The SAR values averaged over 1g tissue masses were determined for the sample DUT for all test 
configurations listed in section 10.2.  
 
11.1  SAR Results 

 
Tables below displays the SAR results. 
 

Table: SAR MEASUREMENT RESULTS – 850MHz GPRS 

Table 56 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 55.2 

5% 
52.4 to 58.0) 

 

(target 0.97 5% 
0.92 to 1.02) 

Tune –Up 
SAR 

(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
29-10-14 

‐ 
GPRS 
Class 10 (0) 

128  824.2 
Noise 
Floor 

N/A  55.58  0.9798  N/A 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

1. 
GPRS 
Class 10 (0) 

128  824.2  0.557  0.01 55.58 0.9798 0.718 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

2. 
GPRS 
Class 10 (0) 

190  836.6  0.535  0.05 55.47 0.9917 0.697 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

3. 
GPRS 
Class 10 (0) 

251  848.6  0.462  -0.04 55.33 1.005 0.615 

Lap Held Antenna IN  
29-10-14 

‐ 
GPRS 
Class 10 (0) 

128  824.2 
Noise 
Floor

N/A 55.58 0.9798 N/A 

Lap Held Antenna OUT  
29-10-14 

4. 
GPRS 
Class 10 (0) 

128  824.2  1.03  0.07 55.58 0.9798 1.327 

Lap Held Antenna OUT  
29-10-14  5. 

GPRS 
Class 10 (0) 

190  836.6  0.993  -0.02  55.47  0.9917  1.294 

Lap Held Antenna OUT  
29-10-14  6. 

GPRS 
Class 10 (0) 

251  848.6  0.852  0  55.33  1.005  1.134 

Lap Held Antenna OUT  
29-10-14 Variability   7. 

GPRS 
Class 10 (0) 

128  824.2  1.09  -0.21  55.58  0.9798  1.404 

Edge 2 Antenna IN  29-
10-14  8. 

GPRS 
Class 10 (0) 

128  824.2  0.377  -0.18  55.58  0.9798  0.486 

Edge 2 Antenna IN  29-
10-14 

9. 
GPRS 
Class 10 (0) 

190  836.6  0.285  -0.19  55.47  0.9917  0.371 

Edge 2 Antenna IN  29-
10-14 

10. 
GPRS 
Class 10 (0) 

251  848.6  0.252  -0.14  55.33  1.005  0.335 

Edge 3 Antenna IN  29-
10-14 

‐ 
GPRS 
Class 10 (0) 

128  824.2 
Noise 
Floor

N/A  55.58  0.9798  N/A 

Edge 3 Antenna OUT  
29-10-14  11. 

GPRS 
Class 10 (0) 

128  824.2  0.168  -0.02  55.58  0.9798  0.216 

Edge 3 Antenna OUT  
29-10-14  12. 

GPRS 
Class 10 (0) 

190  836.6  0.188  0.06  55.47  0.9917  0.245 

Edge 3 Antenna OUT  
29-10-14 13. 

GPRS 
Class 10 (0) 

251 848.6 0.185 0.02 55.33 1.005 0.246 

System Check 29-10-14 14. CW 1 900 2.91 0 54.87 1.056 N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 1900MHz GPRS 

Table 57 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 53.3 

5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –Up 
SAR 

(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
25-11-14 

‐ 
GPRS Class 
10 (0) 

661  1880 
Noise 
floor 

N/A  51.68  1.558  N/A 

Bystander 25mm 
Spacing Antenna OUT  
25-11-14 

15. 
GPRS Class 
10 (0) 

512  1850  0.209  0.11 51.83 1.537 0.379 

Bystander 25mm 
Spacing Antenna OUT  
25-11-14 

16. 
GPRS Class 
10 (0) 

661  1880  0.198  -0.12 51.68 1.558 0.340 

Bystander 25mm 
Spacing Antenna OUT  
25-11-14 

17. 
GPRS Class 
10 (0) 

810  1910  0.215  -0.1 51.57 1.578 0.381 

Lap Held Antenna IN  
25-11-14  ‐ 

GPRS Class 
10 (0) 

661  1880 
Noise 
floor

N/A 51.68 1.558 N/A 

Lap Held Antenna OUT  
25-11-14  18. 

GPRS Class 
10 (0) 

512  1850  0.39  0.01 51.83 1.537 0.708 

Lap Held Antenna OUT  
25-11-14  19. 

GPRS Class 
10 (0) 

661  1880  0.357  -0.03  51.68  1.558  0.613 

Lap Held Antenna OUT  
25-11-14  20. 

GPRS Class 
10 (0) 

810  1910  0.363  -0.1  51.57  1.578  0.643 

Edge 2 Antenna IN  25-
11-14  21. 

GPRS Class 
10 (0) 

512  1850  0.525  0.09  51.83  1.537  0.953 

Edge 2 Antenna IN  25-
11-14 

22. 
GPRS Class 
10 (0) 

661  1880  0.512  0.12  51.68  1.558  0.880 

Edge 2 Antenna IN  25-
11-14 

23. 
GPRS Class 
10 (0) 

810  1910  0.518  -0.05  51.57  1.578  0.917 

Edge 3 Antenna IN  25-
11-14 

‐ 
GPRS Class 
10 (0) 

661  1880 
Noise 
floor

N/A  51.68  1.558  N/A 

Edge 3 Antenna OUT  
25-11-14  24. 

GPRS Class 
10 (0) 

512  1850  0.343  -0.03  51.83  1.537  0.623 

Edge 3 Antenna OUT  
25-11-14  25. 

GPRS Class 
10 (0) 

661  1880  0.267  -0.06  51.68  1.558  0.459 

Edge 3 Antenna OUT  
25-11-14  26. 

GPRS Class 
10 (0) 

810  1910  0.284  -0.15  51.57  1.578  0.284 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
 



 WWAN - FCC ID: EJE-EM7355D IC: 337J-EM7355D Report No. M141025R_FCC_EM7355_SAR_GSM-UMTS            Page 43 of 485 

  

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 

 
 

 
Table: SAR MEASUREMENT RESULTS – 850MHz UMTS 

 

Table 58 

Test Position  Plot 
No. 

Test 
Mode 

Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 55.2 5% 
52.4 to 58.0) 

 

(target 0.97 5% 
0.92 to 1.02) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
28-10-14 

‐ 
WCDMA - 
UMTS (0) 

4183  836.6 
Noise 
Floor 

N/A  55.04  1.002  N/A 

Bystander 25mm 
Spacing Antenna OUT  
28-10-14 

27. 
WCDMA - 
UMTS (0) 

4132  826.4  0.483  0.05 55.14 0.991 0.587 

Bystander 25mm 
Spacing Antenna OUT  
28-10-14 

28. 
WCDMA - 
UMTS (0) 

4183  836.6  0.479  0.01 55.04 1.002 0.564 

Bystander 25mm 
Spacing Antenna OUT  
28-10-14 

29. 
WCDMA - 
UMTS (0) 

4233  846.6  0.446  0.02 54.96 1.013 0.546 

Lap Held Antenna IN  
28-10-14  ‐ 

WCDMA - 
UMTS (0) 

4183  836.6 
Noise 
Floor

N/A 55.04 1.002 N/A 

Lap Held Antenna OUT  
28-10-14 

30. 
WCDMA - 
UMTS (0) 

4132  826.4  0.481  0.02 55.14 0.991 0.585 

Lap Held Antenna OUT  
28-10-14 

31. 
WCDMA - 
UMTS (0) 

4183  836.6  0.476  -0.19  55.04  1.002  0.561 

Lap Held Antenna OUT  
28-10-14 

32. 
WCDMA - 
UMTS (0) 

4233  846.6  0.451  0.1  54.96  1.013  0.552 

Edge 2 Antenna IN  28-
10-14 

33. 
WCDMA - 
UMTS (0) 

4132  826.4  0.191  0.1  55.14  0.991  0.232 

Edge 2 Antenna IN  28-
10-14  34. 

WCDMA - 
UMTS (0) 

4183  836.6  0.199  -0.05  55.04  1.002  0.234 

Edge 2 Antenna IN  28-
10-14  35. 

WCDMA - 
UMTS (0) 

4233  846.6  0.207  -0.03  54.96  1.013  0.253 

Edge 3 Antenna IN  28-
10-14  ‐ 

WCDMA - 
UMTS (0) 

4183  836.6 
Noise 
Floor

N/A  55.04  1.002  N/A 

Edge 3 Antenna OUT  
28-10-14  ‐ 

WCDMA - 
UMTS (0) 

4183  836.6 
Noise 
Floor

N/A  55.04  1.002  N/A 

System Check 28-10-14  36. CW  1  900  2.89  -0.01  54.46  1.066  N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 1700MHz UMTS 

Table 59 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna IN 21-
11-14 

‐ 
WCDMA - 
UMTS (0) 

1427  1735 
Noise 
Floor 

N/A  51.08  1.511  N/A 

Bystander 25mm 
Spacing Antenna OUT 
21-11-14 

37. 
WCDMA - 
UMTS (0) 

1312  1712  0.131  -0.13 51.14 1.493 0.195 

Bystander 25mm 
Spacing Antenna OUT 
21-11-14 

38. 
WCDMA - 
UMTS (0) 

1427  1735  0.151  -0.06 51.08 1.511 0.217 

Bystander 25mm 
Spacing Antenna OUT 
21-11-14 

39. 
WCDMA - 
UMTS (0) 

1513  1753  0.162  -0.01 51.02 1.522 0.233 

Lap Held Antenna IN 
21-11-14  ‐ 

WCDMA - 
UMTS (0) 

1427  1735 
Noise 
Floor

N/A 51.08 1.511 N/A 

Lap Held Antenna OUT 
21-11-14 

40. 
WCDMA - 
UMTS (0) 

1312  1712  0.359  0 51.14 1.493 0.533 

Lap Held Antenna OUT 
21-11-14 

41. 
WCDMA - 
UMTS (0) 

1427  1735  0.388  -0.13  51.08  1.511  0.557 

Lap Held Antenna OUT 
21-11-14 

42. 
WCDMA - 
UMTS (0) 

1513  1753  0.39  -0.07  51.02  1.522  0.561 

Edge 2 Antenna IN 21-
11-14  43. 

WCDMA - 
UMTS (0) 

1312  1712  0.76  0.06  51.14  1.493  1.129 

Edge 2 Antenna IN 21-
11-14  44. 

WCDMA - 
UMTS (0) 

1427  1735  0.712  -0.06  51.08  1.511  1.022 

Edge 2 Antenna IN 21-
11-14  45. 

WCDMA - 
UMTS (0) 

1513  1753  0.698  -0.08  51.02  1.522  1.004 

Edge 3 Antenna IN 21-
11-14  ‐ 

WCDMA - 
UMTS (0) 

1427  1735 
Noise 
Floor

N/A  51.08  1.511  N/A 

Edge 3 Antenna OUT 
21-11-14 

46. 
WCDMA - 
UMTS (0) 

1312  1712  0.305  -0.02  51.14  1.493  0.453 

Edge 3 Antenna OUT 
21-11-14 

47. 
WCDMA - 
UMTS (0) 

1427  1735  0.343  -0.04  51.08  1.511  0.492 

Edge 3 Antenna OUT 
21-11-14 

48. 
WCDMA - 
UMTS (0) 

1513  1753  0.357  -0.07  51.02  1.522  0.514 

System Check 21-11-14  49. CW (0)  1  1800  9.64  -0.06  50.8  1.555  9.640 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 1900MHz UMTS 

Table 60 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift
(dB) 

r 
(target 53.3 5%
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –Up 
SAR 

(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
24-11-14 

‐ 
WCDMA - 
UMTS (0) 

9538  1908 
Noise 
floor 

N/A  53.65  1.564  N/A 

Bystander 25mm 
Spacing Antenna OUT  
24-11-14 

50. 
WCDMA - 
UMTS (0) 

9262  1852  0.228  0.06 53.88 1.536 0.366 

Bystander 25mm 
Spacing Antenna OUT  
24-11-14 

51. 
WCDMA - 
UMTS (0) 

9400  1880  0.234  -0.1 53.76 1.552 0.374 

Bystander 25mm 
Spacing Antenna OUT  
24-11-14 

52. 
WCDMA - 
UMTS (0) 

9538  1908  0.258  0.03 53.65 1.564 0.401 

Lap Held Antenna IN  
24-11-14  ‐ 

WCDMA - 
UMTS (0) 

9538  1908 
Noise 
floor

N/A 53.65 1.564 N/A 

Lap Held Antenna OUT  
24-11-14 

53. 
WCDMA - 
UMTS (0) 

9262  1852  0.37 
-

0.13 
53.88 1.536 0.595 

Lap Held Antenna OUT  
24-11-14 

54. 
WCDMA - 
UMTS (0) 

9400  1880  0.366 
-

0.01
53.76  1.552  0.585 

Lap Held Antenna OUT  
24-11-14 

55. 
WCDMA - 
UMTS (0) 

9538  1908  0.36  -0.1  53.65  1.564  0.560 

Edge 2 Antenna IN  24-
11-14  56. 

WCDMA - 
UMTS (0) 

9262  1852  0.675 
-

0.19
53.88  1.536  1.085 

Edge 2 Antenna IN  24-
11-14  57. 

WCDMA - 
UMTS (0) 

9400  1880  0.577 
-

0.21
53.76  1.552  0.923 

Edge 2 Antenna IN  24-
11-14  58. 

WCDMA - 
UMTS (0) 

9538  1908  0.623 
-

0.03
53.65  1.564  0.969 

Edge 3 Antenna IN  24-
11-14  ‐ 

WCDMA - 
UMTS (0) 

9538  1908 
Noise 
floor

N/A  53.65  1.564  N/A 

Edge 3 Antenna OUT  
24-11-14 

59. 
WCDMA - 
UMTS (0) 

9262  1852  0.328  0.02  53.88  1.536  0.527 

Edge 3 Antenna OUT  
24-11-14 

60. 
WCDMA - 
UMTS (0) 

9400  1880  0.294 
-

0.06
53.76  1.552  0.470 

Edge 3 Antenna OUT  
24-11-14 

61. 
WCDMA - 
UMTS (0) 

9538  1908  0.279 
-

0.04
53.65  1.564  0.434 

System Check 24-11-14  62. CW (0)  1  1950  10.1  0  53.56  1.578  10.100 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 



 WWAN - FCC ID: EJE-EM7355D IC: 337J-EM7355D Report No. M141025R_FCC_EM7355_SAR_GSM-UMTS            Page 46 of 485 

  

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 

 
 

Table: SAR MEASUREMENT RESULTS – 850MHz CDMA BC0 
 

Table 61 

Test Position  Plot 
No. 

Test Mode  Test
Ch. 
 

Test
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
29-10-14 

‐  CDMA2000   384  836.5 
Noise 
Floor 

N/A  56.79  0.9996  N/A 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

63. CDMA2000   1013  824.7  0.397  -0.04 56.94 0.9882 0.449 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

64. CDMA2000   384  836.5  0.401  -0.02 56.79 0.9996 0.444 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

65. CDMA2000   777  848.3  0.353  0 56.67 1.013 0.425 

Lap Held Antenna IN  
29-10-14  ‐  CDMA2000   384  836.5 

Noise 
Floor

N/A 56.79 0.9996 N/A 

Lap Held Antenna OUT  
29-10-14  66. CDMA2000   1013  824.7  0.578  -0.1 56.94 0.9882 0.653 

Lap Held Antenna OUT  
29-10-14  67. CDMA2000   384  836.5  0.588  -0.02  56.79  0.9996  0.651 

Lap Held Antenna OUT  
29-10-14 

68. CDMA2000   777  848.3  0.524  -0.01  56.67  1.013  0.631 

Edge 2 Antenna IN   
29-10-14 

69. CDMA2000   1013  824.7  0.178  -0.1  56.94  0.9882  0.201 

Edge 2 Antenna IN   
29-10-14 

70. CDMA2000   384  836.5  0.186  -0.01  56.79  0.9996  0.206 

Edge 2 Antenna IN   
29-10-14 

71. CDMA2000   777  848.3  0.178  0.15  56.67  1.013  0.214 

Edge 3 Antenna IN   
29-10-14  ‐  CDMA2000   384  836.5 

Noise 
Floor

N/A  56.79  0.9996  N/A 

Edge 3 Antenna OUT  
29-10-14  72. CDMA2000   1013  824.7  0.101  0  56.94  0.9882  0.114 

Edge 3 Antenna OUT  
29-10-14  73. CDMA2000   384  836.5  0.114  0.05  56.79  0.9996  0.126 

Edge 3 Antenna OUT  
29-10-14 

74. CDMA2000   777  848.3  0.109  0.02  56.67  1.013  0.131 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 850MHz CDMA BC10 
 

Table 62 

Test Position  Plot 
No. 

Test Mode  Test
Ch. 
 

Test
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
29-10-14 

‐  CDMA2000   684  823.1 
Noise 
Floor 

N/A  56.94  0.9858  N/A 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

75. CDMA2000   476  817.9  0.408  0 57.02 0.9818 0.454 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

76. CDMA2000   560  820  0.411  0.01 56.99 0.984 0.450 

Bystander 25mm 
Spacing Antenna OUT  
29-10-14 

77. CDMA2000   684  823.1  0.404  0.07 56.94 0.9858 0.428 

Lap Held Antenna IN  
29-10-14  ‐  CDMA2000   684  823.1 

Noise 
Floor

N/A 56.94 0.9858 N/A 

Lap Held Antenna OUT  
29-10-14  78. CDMA2000   476  817.9  0.625  -0.01 57.02 0.9818 0.695 

Lap Held Antenna OUT  
29-10-14  79. CDMA2000   560  820  0.63  -0.05  56.99  0.984  0.689 

Lap Held Antenna OUT  
29-10-14 

80. CDMA2000   684  823.1  0.615  -0.2  56.94  0.9858  0.651 

Edge 2 Antenna IN  29-
10-14 

81. CDMA2000   476  817.9  0.147  0.19  57.02  0.9818  0.163 

Edge 2 Antenna IN  29-
10-14 

82. CDMA2000   560  820  0.146  -0.01  56.99  0.984  0.160 

Edge 2 Antenna IN  29-
10-14 

83. CDMA2000   684  823.1  0.138  -0.09  56.94  0.9858  0.146 

Edge 3 Antenna IN  29-
10-14  ‐  CDMA2000   684  823.1 

Noise 
Floor

N/A  56.94  0.9858  N/A 

Edge 3 Antenna OUT  
29-10-14  84. CDMA2000   476  817.9  0.124  -0.04  57.02  0.9818  0.138 

Edge 3 Antenna OUT  
29-10-14  85. CDMA2000   560  820  0.126  -0.03  56.99  0.984  0.138 

Edge 3 Antenna OUT  
29-10-14 

86. CDMA2000   684  823.1  0.128  0.11  56.94  0.9858  0.136 

System Check  87. CW  1  900  2.93  0  56.16  1.065  N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 1900MHz CDMA BC1 
 

Table 63 

Test Position  Plot 
No. 

Test Mode  Test
Ch. 
 

Test
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna IN  
25-11-14 

‐  CDMA2000   1175  1909 
Noise 
Floor 

N/A  51.58  1.577  N/A 

Bystander 25mm 
Spacing Antenna OUT  
25-11-14 

88. CDMA2000   25  1851  0.196  -0.09 51.83 1.536 0.276 

Bystander 25mm 
Spacing Antenna OUT  
25-11-14 

89. CDMA2000   600  1880  0.197  -0.11 51.68 1.558 0.285 

Bystander 25mm 
Spacing Antenna OUT  
25-11-14 

90. CDMA2000   1175  1909  0.226  0 51.58 1.577 0.301 

Lap Held Antenna IN  
25-11-14  ‐  CDMA2000   1175  1909 

Noise 
Floor

N/A 51.58 1.577 N/A 

Lap Held Antenna OUT  
25-11-14  91. CDMA2000   25  1851  0.465  -0.18 51.83 1.536 0.654 

Lap Held Antenna OUT  
25-11-14  92. CDMA2000   600  1880  0.425  -0.16  51.68  1.558  0.616 

Lap Held Antenna OUT  
25-11-14 

93. CDMA2000   1175  1909  0.501  0.02  51.58  1.577  0.668 

Edge 2 Antenna IN   
25-11-14 

94. CDMA2000   25  1851  0.705  -0.18  51.83  1.536  0.991 

Edge 2 Antenna IN   
25-11-14 

95. CDMA2000   600  1880  0.419  0.02  51.68  1.558  0.607 

Edge 2 Antenna IN   
25-11-14 

96. CDMA2000   1175  1909  0.709  -0.02  51.58  1.577  0.945 

Edge 3 Antenna IN   
25-11-14  ‐  CDMA2000   1175  1909 

Noise 
Floor

N/A  51.58  1.577  N/A 

Edge 3 Antenna OUT  
25-11-14  97. CDMA2000   25  1851  0.416  -0.01  51.83  1.536  0.585 

Edge 3 Antenna OUT  
25-11-14  98. CDMA2000   600  1880  0.343  -0.16  51.68  1.558  0.497 

Edge 3 Antenna OUT  
25-11-14 

99. CDMA2000   1175  1909  0.387  -0.07  51.58  1.577  0.516 

System Check 25-11-14 100. CDMA2000  1 1950 10.3 0.02 51.43 1.599 N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 700MHz LTE 

Table 64 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna 
IN 1RB 31-10-14 

‐ 
LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800  711 
Noise 
Floor 

N/A  56.28  0.9223  N/A 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 31-10-14 

101. 
LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23780  709  0.125  -0.06 56.36 0.9193 0.133 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 31-10-14 

102. 
LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23790  710  0.129  -0.02 56.34 0.9219 0.134 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 31-10-14 

103. 
LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800  711  0.126  -0.07 56.28 0.9223 0.127 

Bystander 25mm 
Spacing Antenna 
OUT 25RB 31-10-
14 

104. 
LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23780  709  0.107  0 56.36 0.9193 0.140 

Bystander 25mm 
Spacing Antenna 
OUT 25RB 31-10-
14 

105. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23790  710  0.106  -0.11 56.34 0.9219 0.138 

Bystander 25mm 
Spacing Antenna 
OUT 25RB 31-10-
14 

106. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23800  711  0.109  -0.01  56.28  0.9223  0.144 

Lap Held Antenna 
IN 1RB 31-10-14  ‐ 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800  711 
Noise 
Floor 

N/A  56.28  0.9223  N/A 

Lap Held Antenna 
OUT 1RB 31-10-14  107. 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23780  709  0.359  0.08  56.36  0.9193  0.383 

Lap Held Antenna 
OUT 1RB 31-10-14  108. 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23790  710  0.466  -0.02  56.34  0.9219  0.486 

Lap Held Antenna 
OUT 1RB 31-10-14  109. 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800  711  0.375  -0.11  56.28  0.9223  0.379 

Lap Held Antenna 
OUT 25RB 31-10-
14 

110. 
LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23780  709  0.33  0.03  56.36  0.9193  0.431 

Lap Held Antenna 
OUT 25RB 31-10-
14 

111. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23790  710  0.38  -0.07  56.34  0.9219  0.495 

Lap Held Antenna 
OUT 25RB 31-10-
14 

112. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23800  711  0.298  -0.07  56.28  0.9223  0.393 

Edge 2 Antenna IN 
1RB 31-10-14  113. 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23780  709  0.279  0.03  56.36  0.9193  0.298 

Edge 2 Antenna IN 
1RB 31-10-14 114. 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23790 710 0.276 0 56.34 0.9219 0.288 

Edge 2 Antenna IN 
1RB 31-10-14 115. 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800 711 0.223 0.1 56.28 0.9223 0.226 

Edge 2 Antenna IN 
25RB 31-10-14 116. 

LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23780 709 0.217 -0.05 56.36 0.9193 0.283 

Edge 2 Antenna IN 
25RB 31-10-14 

117. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23790 710 0.216 0.06 56.34 0.9219 0.281 
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Edge 2 Antenna IN 
25RB 31-10-14 

118. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23800 711 0.171 -0.07 56.28 0.9223 0.225 

Edge 3 Antenna IN 
1 RB 31-10-14 ‐ 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800 711 
Noise 
Floor 

N/A 56.28 0.9223 N/A 

Edge 3 Antenna 
OUT 1RB 31-10-14 119. 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23780 709 0.119 0.04 56.36 0.9193 0.127 

Edge 3 Antenna 
OUT 1RB 31-10-14 120. 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23790 710 0.123 0.03 56.34 0.9219 0.128 

Edge 3 Antenna 
OUT 1RB 31-10-14 121. 

LTE FDD 
10MHz QPSK  
(1RB Low) (0) 

23800 711 0.131 0.05 56.28 0.9223 0.133 

Edge 3 Antenna 
OUT 25RB 31-10-
14 

122. 
LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23780 709 0.106 0.04 56.36 0.9193 0.138 

Edge 3 Antenna 
OUT 25RB 31-10-
14 

123. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23790 710 0.103 -0.02 56.34 0.9219 0.134 

Edge 3 Antenna 
OUT 25RB 31-10-
14 

124. 

LTE FDD 
10MHz QPSK  
(25RB Low) 
(0) 

23800 711 0.107 0.07 56.28 0.9223 0.141 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 750MHz LTE 

Table 65 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna 
IN 1RB 31-10-14 

‐ 
LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230  782 
Noise 
Floor 

N/A  55.46  0.9898  N/A 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 31-10-14 

125. 
LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230  782  0.282  -0.06  55.46  0.9898  0.305 

Bystander 25mm 
Spacing Antenna 
OUT 25RB 31-10-
14 

126. 
LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23230  782  0.214  -0.01  55.46  0.9898  0.295 

Lap Held Antenna 
IN 1RB 31-10-14 ‐ 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230  782 
Noise 
Floor 

N/A  55.46  0.9898  N/A 

Lap Held Antenna 
OUT 1RB 31-10-14 127. 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230 782 0.555 -0.16 55.46 0.9898 0.600 

Lap Held Antenna 
OUT 25RB 31-10-
14 

128. 
LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23230 782 0.425 -0.03 55.46 0.9898 0.587 

Edge 2 Antenna IN 
1RB 31-10-14 129. 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230 782 0.295 -0.08 55.46 0.9898 0.319 

Edge 2 Antenna IN 
25RB 31-10-14 130. 

LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23230 782 0.221 -0.03 55.46 0.9898 0.305 

Edge 3 Antenna IN 
1RB 31-10-14 ‐ 

LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230 782 
Noise 
Floor 

N/A 55.46 0.9898 N/A 

Edge 3 Antenna 
OUT 1RB 31-10-14 

131. 
LTE FDD 
10MHz QPSK  
(1RB Mid) (0) 

23230 782 0.0791 -0.05 55.46 0.9898 0.086 

Edge 3 Antenna 
OUT 25RB 31-10-
14 

132. 
LTE FDD 
10MHz QPSK  
(25RB Mid) (0) 

23230 782 0.0608 -0.14 55.46 0.9898 0.084 

System Check  31-
10--14 133. CW (0) 1 750 2.01 -0.03 55.81 0.9571 N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 1700MHz LTE 

Table 66 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna 
IN 1RB 21-11-14 

‐ 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175  1733 
Noise 
Floor 

N/A  51.09  1.509  N/A 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 21-11-14 

134. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20050  1720  0.161  -0.13 51.11 1.5 0.235 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 21-11-14 

135. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175  1733  0.17  -0.03 51.09 1.509 0.233 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 21-11-14 

136. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20300  1745  0.168  -0.04 51.02 1.517 0.237 

Bystander 25mm 
Spacing Antenna 
OUT 50RB  
21-11-14 

137. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20050  1720  0.121  -0.02 51.11 1.5 0.234 

Bystander 25mm 
Spacing Antenna 
OUT 50RB  
21-11-14 

138. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20175  1733  0.127  -0.06 51.09 1.509 0.236 

Bystander 25mm 
Spacing Antenna 
OUT 50RB  
21-11-14 

139. 

LTE FDD 
20MHz QPSK  
(50RB Low) 
(0) 

20300  1745  0.13  -0.06  51.02  1.517  0.237 

Lap Held Antenna 
IN 1RB 21-11-14  ‐ 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175  1733 
Noise 
Floor 

N/A  52.8  1.52  N/A 

Lap Held Antenna 
OUT 1RB 21-11-14  140. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20050  1720  0.419  0.13  52.83  1.509  0.611 

Lap Held Antenna 
OUT 1RB 21-11-14  141. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175  1733  0.448  -0.04  52.8  1.52  0.614 

Lap Held Antenna 
OUT 1RB 21-11-14  142. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20300  1745  0.419  0.09  52.73  1.53  0.592 

Lap Held Antenna 
OUT 50RB  
21-11-14 

143. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20050  1720  0.317  -0.03  52.83  1.509  0.612 

Lap Held Antenna 
OUT 50RB 24-11-
14 

144. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20175  1733  0.295  -0.08  51.08  1.506  0.549 

Lap Held Antenna 
OUT 50RB  
24-11-14 

145. 

LTE FDD 
20MHz QPSK  
(50RB Low) 
(0) 

20300  1745  0.302  0.01  51.05  1.513  0.550 

Edge 2 Antenna IN 
1RB 24-11-14  146. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20050  1720  0.615  -0.2  51.11  1.495  0.897 

Edge 2 Antenna IN 
1RB 24-11-14 147. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175 1733 0.629 -0.03 51.08 1.506 0.862 

Edge 2 Antenna IN 
1RB 24-11-14 148. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20300 1745 0.611 -0.09 51.05 1.513 0.863 

Edge 2 Antenna IN 
50RB 24-11-14 149. 

LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20050 1720 0.494 0.04 51.11 1.495 0.954 

Edge 2 Antenna IN 
50RB 24-11-14 

150. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20175 1733 0.486 -0.08 51.08 1.506 0.905 

Edge 2 Antenna IN 
50RB 24-11-14 

151. 

LTE FDD 
20MHz QPSK  
(50RB Low) 
(0) 

20300 1745 0.483 -0.05 51.05 1.513 0.879 
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Edge 3 Antenna IN 
1RB 24-11-14 ‐ 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175 1733 
Noise 
Floor 

N/A 51.08 1.506 N/A 

Edge 3 Antenna 
OUT 1RB 24-11-14 152. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20050 1720 0.352 -0.06 51.11 1.495 0.514 

Edge 3 Antenna 
OUT 1RB 24-11-14 

153. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20175 1733 0.379 -0.06 51.08 1.506 0.520 

Edge 3 Antenna 
OUT 1RB 24-11-14 

154. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

20300 1745 0.375 -0.03 51.05 1.513 0.530 

Edge 3 Antenna 
OUT 50RB  
24-11-14 

155. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20050 1720 0.256 -0.01 51.11 1.495 0.495 

Edge 3 Antenna 
OUT 50RB  
24-11-14 

156. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

20175 1733 0.279 -0.04 51.08 1.506 0.520 

Edge 3 Antenna 
OUT 50RB  
24-11-14 

157. 

LTE FDD 
20MHz QPSK  
(50RB Low) 
(0) 

20300 1745 0.29 0.04 51.05 1.513 0.528 

System Check   
24-11-14 158. CW (0) 1 1800 9.52 -0.03 50.83 1.552 N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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Table: SAR MEASUREMENT RESULTS – 1900MHz LTE 

Table 67 

Test Position  Plot 
No. 

Test Mode  Test 
Ch. 
 

Test 
Freq. 
(MHz) 

SAR 
(1g) 

mW/g 

Drift 
(dB) 

r 
(target 53.3 5% 
50.6 to 56.0) 

 
(target 1.52 5% 
1.44 to 1.60) 

Tune –
Up SAR 
(W/kg) 

Bystander 25mm 
Spacing Antenna 
IN 1RB 26-11-14 

‐ 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590  1905 
Noise 
Floor 

N/A  51.77  1.549  N/A 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 26-11-14 

159. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26140  1860  0.168  0.1 51.95 1.52 0.249 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 26-11-14 

160. 
LTE FDD 
20MHz QPSK  
(1RB Low) (0) 

26365  1883  0.154  -0.19 51.85 1.536 0.230 

Bystander 25mm 
Spacing Antenna 
OUT 1RB 26-11-14 

161. 
LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590  1905  0.188  -0.2 51.77 1.549 0.272 

Bystander 25mm 
Spacing Antenna 
OUT 50RB 26-11-
14 

162. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26140  1860  0.13  -0.09 51.95 1.52 0.252 

Bystander 25mm 
Spacing Antenna 
OUT 50RB 26-11-
14 

163. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

26365  1883  0.13  -0.02 51.85 1.536 0.258 

Bystander 25mm 
Spacing Antenna 
OUT 50RB 26-11-
14 

164. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26590  1905  0.142  0.01  51.77  1.549  0.278 

Lap Held Antenna 
IN 1RB 26-11-14  ‐ 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590  1905 
Noise 
Floor 

N/A  51.77  1.549  N/A 

Lap Held Antenna 
OUT 1RB 26-11-14  165. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26140  1860  0.395  0.16  51.95  1.52  0.586 

Lap Held Antenna 
OUT 1RB 26-11-14  166. 

LTE FDD 
20MHz QPSK  
(1RB Low) (0) 

26365  1883  0.317  -0.21  51.85  1.536  0.474 

Lap Held Antenna 
OUT 1RB 26-11-14  167. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590  1905  0.384  -0.04  51.77  1.549  0.556 

Lap Held Antenna 
OUT 50RB 26-11-
14 

168. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26140  1860  0.317  -0.04  51.95  1.52  0.615 

Lap Held Antenna 
OUT 50RB 26-11-
14 

169. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

26365  1883  0.307  -0.05  51.85  1.536  0.610 

Lap Held Antenna 
OUT 50RB 26-11-
14 

170. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26590  1905  0.322  -0.07  51.77  1.549  0.629 

Edge 2 Antenna IN 
1RB 26-11-14  171. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26140  1860  0.714  -0.06  51.95  1.52  1.059 

Edge 2 Antenna IN 
1RB 26-11-14 172. 

LTE FDD 
20MHz QPSK  
(1RB Low) (0) 

26365 1883 0.363 -0.17 51.85 1.536 0.543 

Edge 2 Antenna IN 
1RB 26-11-14 173. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590 1905 0.377 -0.12 51.77 1.549 0.546 

Edge 2 Antenna IN 
50RB 26-11-14 174. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26140 1860 0.43 -0.15 51.95 1.52 0.835 

Edge 2 Antenna IN 
50RB 26-11-14 175. 

LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

26365 1883 0.387 -0.08 51.85 1.536 0.769 
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Edge 2 Antenna IN 
50RB 26-11-14 

176. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26590 1905 0.415 -0.02 51.77 1.549 0.811 

Edge 3 Antenna IN 
1RB 26-11-14 ‐ 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590 1905 
Noise 
Floor 

N/A 51.77 1.549 N/A 

Edge 3 Antenna 
OUT 1RB 26-11-14 177. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26140 1860 0.436 -0.09 51.95 1.52 0.646 

Edge 3 Antenna 
OUT 1RB 26-11-14 178. 

LTE FDD 
20MHz QPSK  
(1RB Low) (0) 

26365 1883 0.305 -0.05 51.85 1.536 0.456 

Edge 3 Antenna 
OUT 1RB 26-11-14 179. 

LTE FDD 
20MHz QPSK  
(1RB High) (0) 

26590 1905 0.312 0.02 51.77 1.549 0.452 

Edge 3 Antenna 
OUT 50RB 26-11-
14 

180. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26140 1860 0.277 0.01 51.95 1.52 0.538 

Edge 3 Antenna 
OUT 50RB 26-11-
14 

181. 
LTE FDD 
20MHz QPSK  
(50RB Mid) (0) 

26365 1883 0.24 -0.11 51.85 1.536 0.477 

Edge 3 Antenna 
OUT 50RB 26-11-
14 

182. 

LTE FDD 
20MHz QPSK  
(50RB High) 
(0) 

26590 1905 0.266 0.01 51.77 1.549 0.520 

System Check 26-
11-14 183. CW (0) 1 1950 10.1 0.03 51.63 1.568 N/A 

NOTE: The measurement uncertainty of 22.98% was not added to the result. 
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12.0 COMPLIANCE STATEMENT 
 
The Fujitsu Convertable Tablet PC, Model: Lifebook T725 with SIERRA WIRELESS Mini-PCI Wireless WAN 
Module Model: EM7355 was found to comply with the FCC and RSS-102 SAR requirements.  
 
The highest SAR level recorded was 1.09 mW/g for a 1g cube. The manufacturer’s tune up power is stated to 
be 2238 mW Burst Average Power. Scaling the SAR value, the maximum SAR value is 1.404 mW/g.  This 
value was measured at 824.2 MHz (channel 128) in the “Lap Held Antenna OUT ” position in GPRS Class 10  
transmission multislot mode. This was below the limit of 1.6 mW/g for uncontrolled exposure, but was within the 
band of measurement uncertainty around the limit. 
 
The SAR test Variability checks were conducted and the repeated results are included in the SAR results 
tables. 
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13.0 MULTIBAND EVALUATION CONSIDERATIONS 
 
According to the FCC SAR evaluation procedures mentioned in KDB447498, when the sum of SAR results 
(simultaneously transmitting antennas WLAN and WWAN) is > 1.6mW/g, and “the aggregate 1-g SAR is scaled 
by the sum of the differences between maximum tune-up and tested power of each transmitter - [(SAR1 +SAR2 
) * (Pdiff1 + Pdiff2 )]”, simultaneous transmission SAR evaluation is required. 
 
 
Host System #2: 
Multiband evaluation was not required for WWAN (EM7355) and WIFI (7265NGW) because the above 
mentioned sum (and the aggregate) of the worst case SAR results for simultaneusly transmitting antennas was 
found to be lower than SAR limit of 1.6 mW/g (WLAN SAR testing was conducted at Tune-up power level): 
 
SAR WWAN + SAR WLAN Antenna A Lap Held configuration FCC: 
1.404 mW/g + Noise Floor = 1.404 mW/g (Including Tune Up scaling) 
 
SAR WWAN + SAR WLAN Antenna A Lap Held configuration IC: 
1.404 mW/g + 0.068 = 1.472 mW/g (Including Tune Up scaling) 
 
SAR WWAN + SAR WLAN Antenna A Edge 3 configuration FCC/IC: 
0.646 mW/g + Noise Floor = 0.646 mW/g (Including Tune Up scaling) 
 
SAR WWAN + SAR WLAN Antenna A Bystander 25mm Spacing configuration IC: 
0.718 mW/g + 0.031 mW/g = 0.749 mW/g (Including Tune Up scaling) 
 
SAR WWAN + SAR WLAN Antenna A Edge 2 configuration FCC/IC: 
1.129 mW/g + 0.331 mW/g = 1.46 mW/g (Including Tune Up scaling) 
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Diagram Showing Antenna Positions (provided by client) 
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